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安全信息

法规遵从

CY8CKIT-042 PSoC® 4 Pioneer 套件旨在用作实验室环境中硬件和软件的开发平台。该电路板是一个
开放系统设计，它没有外壳保护。因此，在近距离接触中，可能会对其他电器和电气设备造成干忧。
在室内环境中，该产品可能会导致无线干扰。这时，用户需要采取适当的预防措施。同样，不应该在
医疗设备或 RF 器件附近使用该电路板。

增加连接到该产品的连线或修改该产品的默认设置可能会影响它的性能，并对周围的其他设备造成干
扰。如果检测到存在这种干扰，应采取适当的措施降低干扰。

CY8CKIT-042 产品出厂时已经过验证，保证符合 A 类产品的 CE 要求。

CY8CKIT-042 包含静电放电 （ESD）的敏感器件。静电电荷很容易会
聚集在人体或任何设备上，并会不知不觉地释放。高能量的静电释放会
对设备造成永久性伤害。建议采取适当的 ESD 预防措施，以避免降低
其性能或丧失功能。将未使用的 CY8CKIT-042 板存放在受保护的运输
包装里。

过期时间 / 产品回收

从盒子背面显示的制造日期算起，该套件的有效期为五年。请联系离您最
近的回收商处理套件。
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通用安全说明

ESD 保护

ESD 会损坏电路板和相关组件。赛普拉斯建议用户只在 ESD 工作站环境中操作。如果 ESD 工作站不
可用，那么对器件进行操作时，请采取适当的 ESD 保护措施：戴上一个连接到电路板上机架接地（任
何未上漆的金属平面）的防静电手环。

操作电路板

CY8CKIT-042 电路板对 ESD 非常敏感。只能握着电路板的边缘。从盒子里取出电路板后，请将其放
置在一个接地且无静电的平面上。如果允许，请使用一个导电泡沫垫。请勿在平面上滑动该电路板。
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1. 简介

感谢您对 PSoC® 4 Pioneer 套件的关注。该套件提供了物美价廉的解决方案，它展示了 PSoC 4 架构
独特的灵活性。以灵活性为设计目标，该套件支持了与一些第三方的 Arduino™ 扩展板的尺寸相兼容。
它还提供另一个插座，从而能够同 Digilent® Pmod™ 的外设模块相连接。另外，该电路板还集成了
CapSense® 滑条、RGB LED、按键开关、板载 USB 编程器、编程 / 调试插座以及 USB-UART/I2C 桥
接器等功能。该套件支持 5 V 或 3.3 V 的电源电压。

PSoC 4 Pioneer 套件以 PSoC 4200 器件系列为基础，为多种嵌入式应用程序提供了可编程平台。
PSoC 4 是一个基于 ARM® Cortex™-M0 CPU 的混合信号可编程嵌入式系统控制器，可以对该平台架
构进行扩展和重新配置。它集成了可编程和可重新配置的模拟和数字模块，并且能够自动灵活地路由
资源。

1.1 套件内容

PSoC 4 Pioneer 套件包括：

■ PSoC 4 Pioneer 开发板

■ 快速入门指南

■ 标准 USB-A 转 Mini-B 型线缆

■ 六条跳线
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图 1-1.  套件内容

如果发现缺少任一部分，请联系离您最近的赛普拉斯销售办事处，获得帮助：www.cypress.com/go/
support。

http://www.cypress.com/go/support
http://www.cypress.com/go/support
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1.2 PSoC Creator™

PSoC Creator 是最先进、简单易用的集成开发环境 （IDE）。它包含了大量预验证和预配置的 PSoC
组件，用户能够使用这些组件来完成革命性的硬件和软件协同设计。 

使用 PSoC Creator，可以执行以下操作：

■ 拖放各 PSoC 组件到工作区中，以设计原理图

■ 完成各组件之间的布线，并配置 GPIO

■ 使用所包含的组件 API 开发和调试固件

PSoC Creator 通过其集成的编译器工具链和量产编程器，为您提供了完备的开发工具体系。

更多有关信息，请访问 www.cypress.com/Creator。

1.3 入门

通过本用户指南，用户可以了解 PSoC 4 Pioneer 套件。 第 15 页上的软件安装介绍了该套件软件的安
装情况。 第21页上的套件操作详细说明了如何使用编程器和调试器（板上PSoC 5LP或外部MiniProg3
（CY8CKIT-002））来编程 PSoC 4。 第 31 页上的硬件 详细说明了硬件的操作。 第 47 页上的示例代
码详细说明了代码示例。 第 66 页上的进阶主题介绍了以下内容 ：构建PSoC 5LP 的项目、USB-UART
功能以及 PSoC 5LP 的 USB-I2C 功能。 第 113 页上的附录提供了各个原理图、引脚分配、零欧姆电
阻的使用情况、故障排除以及材料表 （BOM）。

www.cypress.com/Creator
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1.4 其他参考资源

赛普拉斯网站（www.cypress.com）上提供了大量资料，这些资料有助于您正确为设计选择所需 PSoC
器件，并能够快速有效地将器件集成到设计中。有关完整的资源列表，请参考 KBA86521 — 如何使用

PSoC 3、 PSoC 4 和 PSoC 5LP 进行设计。下面提供了 PSoC 4 的简要列表： 

■ 概况：PSoC 产品系列、 PSoC 蓝图

■ 产品选型：PSoC 1、PSoC 3、PSoC 4 或 PSoC 5LP。此外，PSoC Creator 还包含一个器件选择

工具。

■ 数据手册：描述并提供了 PSoC 4000、 PSoC 4100 和 PSoC 4200 器件系列的电器规范。

■ CapSense 设计指南：了解如何使用 PSoC 4 器件系列设计电容式触摸感应应用。

■ 应用笔记和代码示例：包括从基本到高级的广泛主题。许多应用笔记包括了代码示例。要想获取
PSoC Creator 所有可用代码示例的完整列表，请访问 PSoC 3/4/5 代码示例。若想访问 PSoC
Creator 中的代码示例，请参考 第 12 页上的 PSoC Creator 中的代码示例。

■ 技术参考手册 （TRM）：对每个 PSoC 4 器件系列中所用的架构和寄存器进行了详细说明。

■ 开发套件：

❐ CY8CKIT-042和CY8CKIT-040等PSoC 4 Pioneer套件均提供了易用且价廉的开发平台。这些套
件包括用于同 Arduino 兼容的屏蔽和 Digilent Pmod 子卡的连接器。

❐ CY8CKIT-049 是一种成本非常低的原型平台，适用于 PSoC 4 器件。

❐ CY8CKIT-001 是所有 PSoC 系列产品共同使用的开发平台。

■ MiniProg3 为器件的闪存编程和调试操作提供了一个接口工具。

■ 知识库文章（KBA）：提供了专家对器件 / 套件的设计和应用技巧。例如，KBA93541 解释了如何

使用 CY8CKIT-049 来编程另一个 PSoC 4 器件。 

www.cypress.com
http://www.cypress.com/?id=4&rID=77024&source=an79953
http://www.cypress.com/?id=4&rID=77024&source=an79953
http://www.cypress.com/psoc
http://www.cypress.com/?rID=86788&source=an79953
http://www.cypress.com/?id=1573&source=an79953
http://www.cypress.com/?id=5041&source=an79953
http://www.cypress.com/?id=4976&source=an79953
http://www.cypress.com/?id=5044&source=an79953
http://www.cypress.com/?rID=94034&source=an79953
http://www.cypress.com/?rID=78805&source=an79953
http://www.cypress.com/?rID=78632&source=an79953
http://www.cypress.com/?rID=78578&source=an79953
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=76&id=4749
http://www.cypress.com/?rID=101641
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=117&id=4749&applicationID=0&l=0
http://www.cypress.com/cypress-store
http://www.cypress.com/go/cy8ckit-042
http://www.cypress.com/?rID=94456&source=an79953
http://www.cypress.com/?rID=92146&source=an79953
http://www.cypress.com/go/cy8ckit-001
http://www.cypress.com/go/cy8ckit-002
http://www.cypress.com/search/all?f[0]=meta_type%3Atechnical_documents&f[1]=resource_meta_type%3A584&f[2]=field_related_products%3A1277
http://www.cypress.com/?id=4&rID=98796
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1.4.1 PSoC Creator

PSoC Creator是一个基于Windows的免费集成开发环境（IDE）。通过它可以同时对PSoC 3、PSoC 4
或 PSoC 5LP 系统进行硬件和固件设计。如图 1-2 所示，使用 PSoC Creator，可以执行以下操作： 

1. 将组件图标拖放到主要设计工作区中，以进行您的硬件系统设计。

2. 对您的应用固件和 PSoC 硬件进行协同设计。

3. 使用配置工具配置各组件

4. 研究包含 100 多个组件的库

5. 查看组件数据手册

图 1-2.  PSoC Creator 特性 

有关学习和使用 PSoC Creator 的视频向导，请参考 PSoC Creator 培训网页。 

http://www.cypress.com/psoccreator/?source=PSoC5LP_Datasheet
http://www.cypress.com/?rID=40547
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1.4.2 PSoC Creator 中的代码示例

PSoC Creator 包含了多个代码示例项目。可以在 PSoC Creator 的 Start Page 中打开这些项目，如

图 1-3 所示。

这些示例项目通过向您提供完整的设计 （并非一个空白设计），从而加快您的设计进程。示例项目还
介绍了如何将 PSoC Creator 组件使用于不同应用中。此外，还包含多个代码示例和数据手册，如

第 13 页上的图 1-4 所示。

在第 13 页上的图 1-4 所示的 Find Example Project 对话框中，您可以选择以下选项：

■ 根据器件系列或关键词筛选示例

■ 从 Filter Options 的示例菜单中进行选择

■ 通过 Documentation （文档）选项卡，查看选中的数据手册

■ 查看选中的代码示例。您可以将该窗口中的代码复制到您的项目中，从而加快代码的开发进程，或

■ 为示例项目创建一个新的工作区。通过为您提供一个完整的基本设计，该方案可加快您的设计过
程。然后，您可以根据自己的应用要求来调整该设计。

图 1-3.  PSoC Creator 中的代码示例 
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图 1-4.  带示例代码的示例项目 

1.4.3 PSoC Creator 帮助

请访问 PSoC Creator 主页以下载 PSoC Creator 的最新版本。然后，启动 PSoC Creator，并导航到

以下各项：

■ 快速入门指南：依次选择 Help > Documentation > Quick Start Guide。本指南提供了有关开发

PSoC Creator 项目的基本知识。

■ 简单的组件示例项目：依次选择 File > Open > Example projects。这些示例项目展示了如何配置

和使用 PSoC Creator 组件。

■ 入门设计：依次选择 File > New> Project> PSoC 4100/PSoC 4200 Starter Designs。这些入门

设计展示了 PSoC 4 的独特特性。

■ 系统参考指南：依次选择 Help > System Reference > System Reference Guide。该指南列出并

描述了 PSoC Creator 提供的系统功能。

■ 组件数据手册 ：右击组件，然后选择“Open Datasheet”项。请访问 PSoC 4 组件数据手册网页，

以下载所有 PSoC 4 组件的数据手册列表。

■ 文档管理工具：PSoC Creator 提供了一款文档管理工具，有助于您寻找和查看文件资源。要想打

开文档管理工具，请选择菜单项：Help > Document Manager。

http://www.cypress.com/?id=2494&source=an79953
http://www.cypress.com/search/all?f[0]=meta_type%3Asoftware_tools&f[1]=field_related_products%3A1314&f[2]=software_tools_meta_type%3A532
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1.4.4 技术支持

若有任何疑问，我们的技术支持团队很乐意为您提供帮助。您可以在赛普拉斯技术支持页面上创建一
个技术支持请求。

如果您在美国，可以通过拨打我们的免费电话，直接与技术支持团队取得联系：+1-800-541-4736。在

提示符处选择第 2 项。

若想快速获得支持，您同样可以使用下面的支持方式。

■ 自助。

■ 所在地销售办事处。

1.5 文档规范

表 1-1.  指南的文档规范

规范 使用说明

Courier New字体
用于显示文件位置、用户输入的文本和源代码：
C:\ ...cd\icc\

斜体字
用于显示文件名称和参考文档：
请阅读 PSoC Creator 用户指南文档中的 sourcefile.hex 文件。

[ 方括号、粗体字 ]
用于显示程序中的键盘指令：
[Enter] 或 [Ctrl] [C]

File （文件） > Open
（打开）

表示菜单路径：
File > Open > New Project

粗体字
用于显示操作过程中的各条指令、菜单路径和图标名称：
请点击 File 图标，然后点击 Open。

Times New Roman 字体
用于显示公式：
2 + 2 = 4

灰色框中的文本 用于说明警告或产品的独特功能。

http://www.cypress.com/?id=4
http://www.cypress.com/support
http://www.cypress.com/?id=1062
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2. 软件安装

2.1 安装套件软件

请按照下面步骤安装 PSoC 4 Pioneer 套件软件：

1. 可以从 www.cypress.com/go/CY8CKIT-042 网址下载并安装 PSoC 4 Pioneer 套件软件。

2. 选择安装 CY8CKIT-042 相关文件的文件夹。选择该目录并点击 Next 按键。

图 2-1.  安装文件夹

www.cypress.com/go/CY8CKIT-042
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3. 选择安装类型并点击 Next 按键。

图 2-2.  Installation Type （安装类型）选项

4. 阅读并接受“End-User Licence Agreement”（终端用户许可协议），然后点击Next以进行安装。

安装完成后，套件内容位于以下位置：
<Install_Directory>\CY8CKIT-042 PSoC 4 Pioneer Kit\<version>

注意：对于使用 Windows 7 的用户，所安装的文件和文件夹是只读的。要想更改属性，右键点击文件

夹并依次选择 Properties > Attributes，然后取消选择 Read-only 按键。依次点击 Apply 和 OK 按

键，关闭该窗口。 

2.2 安装硬件

该套件不要求安装其他的硬件。

2.3 安装软件

当安装 PSoC 4 Pioneer 套件时，用户检查是否在系统中已安装所需的软件。如果尚未安装需要的应

用程序，安装程序将提示您下载并安装这些应用。

所需的软件包括：

■ PSoC Creator 3.2 服务包 1 或更高版本：请在 www.cypress.com/go/Creator 网址上下载最新版本。

■ PSoC Programmer 3.23.1 或更高版本：请在 www.cypress.com/go/Programmer 网址上下载最新

版本。

■ 代码示例：安装该套件后，代码示例将显示在套件固件文件夹内。要安装该套件，请从
 www.cypress.com/go/CY8CKIT-042 网页上下载 CD ISO 镜像或安装各种文件。

www.cypress.com/go/Creator
www.cypress.com/go/Programmer
http://www.cypress.com/go/CY8CKIT-042
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2.4 卸载软件

您可以采取以下方法来卸载软件：

■ 依次选择 Start > All Programs > Cypress > Cypress Update Manager > Cypress Update
Manager，点击 Uninstall 按键。

■ 依次选择 Start > Control Panel > Programs and Features，点击 Uninstall/Change 按键。

2.5 使用代码示例快速轻松地开发代码

通过使用 PSoC Creator 提供的某些示例项目可以快速轻松地开发代码。要想访问这些示例项目，请

在 PSoC Creator 的 Start Page 中点击 Example and Kits 部分下面的 Find ExampleProject… 项，

或导航到 Creator 工具栏菜单并依次选择 File > Example Project。

图 2-1.  查找示例项目

Find Example Project 部分提供的各种滤波器，可允许用户查找最合适的项目。 
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PSoC Creator还为每个器件系列提供了一些入门设计。这些设计详细说明了每个PSoC器件系列的独

特功能。它们为用户提供了一个起点而不是创建一个新的空设计。这些入门项目和各种预选定组件被
一同加载。要想使用某一种入门设计，请导航到 File > New > Project 并选择您需要的设计。

图 2-1.  入门设计 

除了用于 PSoC Creator 的示例项目和入门设计外，赛普拉斯还不断努力地提供最好的支持。要想查

看 PSoC 3、 PSoC 4 和 PSoC 5LP 的不断添加的应用手册列表，请点击此处 。

http://www.cypress.com/search/all?keywords=psoc&f[0]=meta_type%3Atechnical_documents&f[1]=field_related_products%3A1277&f[2]=resource_meta_type%3A574
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2.6 在 PSoC Creator 中打开“Example Project”

1. 从 Start 菜单中启动 PSoC Creator。

图 2-7.  PSoC Creator 启动页

2. 通过点击 Examples and Kits > Kits > CY8CKIT-042 下面的 <Project.cywrk>，可打开启动页中的

示例项目。

图 2-8.  打开示例项目
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3. 示例项目被打开，并将各项目文件显示在工作区浏览器中。本用户指南的以下各节详细说明了如何
构建、编程和了解该套件所支持的示例项目。

图 2-9.  Workspace Explorer （工作区浏览器）
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3. 套件操作

通过 PSoC 4 系列器件、Arduino 扩展板以及 Digilent Pmod 子卡，PSoC 4 Pioneer 套件可用于开发
各种应用。图 3-1 是 PSoC 4 Pioneer 开发板的图示，图示中标记出了板上的每一个组件。

图 3-1.  PSoC 4 Pioneer 开发板

Programmer 
Status LED

USB Connector 
(J10)

Power LED

PSoC 4 Additional 
Program Header (J6)

PSoC 5LP I/O 
Header (J8)

PSoC 4 
Reset 
Button

Digilent Pmod 
Compatible 

I/O Header (J5)

System Power 
Supply Jumper 

(J9)

Arduino
Compatible 

I/O Header (J3)

Arduino
Compatible 

I/O Header (J4)

Arduino 
Compatible 
I/O Header 

(J1)

PSoC 5LP
Programmer 

and 
Debugger

User 
Button

PSoC 4
44 TQFP

Arduino
Compatible 
I/O Header 

(J2)

VIN (J11)

10‐Pin SWD 
Debug and Programming 
Header (J7) for PSoC 5LP

RGB 
LED

PSoC 4 
Power Supply 
Jumper (J13)

Arduino 
Compatible ICSP
I/O Header (J12)

CapSense
Slider



CY8CKIT-042 PSoC® 4 Pioneer 套件指南， 文档编号：001-90179 版本 *B 22

套件操作

3.1 Pioneer 套件的 USB 接口

PSoC 4 Pioneer 套件通过 USB 接口连接到电脑上。该套件作为复合设备进行枚举，而三个独立设备
显示在 Windows 操作系统中 Device Manager 窗口内。

表 3-1.  枚举后 Device Manager 窗口内显示的 PSoC 4 Pioneer 套件

图 3-2.  KitProg 驱动程序安装

端口 说明

USB 复合器件 复合器件

USB 输入器件 USB-I2C 桥接器， Kitprog 命令接口

KitProg 编程器和调试器

KitProg USB-UART USB-UART 桥接器 （显示为 COM# 端口）
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3.2 对 PSoC 4 进行编程和调试

该套件允许在两种模式下对 PSoC 4 器件进行编程和调试：

■ 使用板上 PSoC 5LP 编程器和调试器

■ 使用 CY8CKIT-002 MiniProg3 编程器和调试器

3.2.1 使用板上的 PSoC 5LP 编程器和调试器

套件的默认编程接口是板上基于 USB 的编程接口。对 PSoC 4 进行编程前，必须安装 PSoC Creator
和 PSoC Programmer。请查看第 15 页上的软件安装 ，了解如何安装套件软件的信息。 

1. 要想编程该器件，请将 USB 线缆插入到编程 USB 连接器 J10 上，如图 3-3 所示。套件将被枚举

成复合设备。更多详细信息，请参考第 22 页上的 Pioneer 套件的 USB 接口 。

图 3-3.  将 USB 线缆连接到 J10

2. 板上 PSoC 5LP 使用了串行线调试（SWD）接口对 PSoC 4 器件进行编程。有关实现该操作的详

细信息，请查看图 3-4。

图 3-4.  使用 PSoC 5LP 通过 SWD 接口编程 PSoC 4
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SWDIO

Reset

P2[1]

P2[0]

P2[4]

P3[2]

P3[3]

XRES
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D+
P15[6]

P15[7]

VDD
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3. Pioneer 套件的板载编程器在 PC 和软件工具中被枚举成 KitProg。加载 PSoC Creator 中的示例

项目（如第 15 页上的软件安装 一节中所介绍的项目），并通过依次点击 Build > Build Project 或
直接按组合键 [Shift]+[F6] 来编译项目。 

图 3-5.  在 PSoC Creator 中创建项目 

4. 编译项目后如果不发生任何错误和警报，请依次选择 Debug > Program 或直接按组合键

[Ctrl]+[F5] 开始编程器件。 

图 3-6.  使用 PSoC Creator 对器件进行编程 

板载编程器仅支持 RESET 编程模式。使用板载编程器时，开发板可由 USB （VBUS）或外部电源
（如 Arduino 扩展板）供电。如果已经使用了外部电源给该开发板供电，那么插入 USB 编程器并不会
损坏开发板。
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3.2.2 使用 CY8CKIT-002 MiniProg3 编程器和调试器

可以使用 MiniProg3 （CY8CKIT-002）来对 Pioneer 套件上的 PSoC 4 器件进行编程。此时，需要使
用开发板上的连接器 J6，如图 3-7 所示。使用 MiniProg3 的编程操作和使用板载编程器的操作相似；
只是，它被枚举成 MiniProg3。 MiniProg3 仅支持 RESET 编程模式。

MiniProg3 在进行编程的同时还能给开发板供电。要想执行该操作，请依次选择 Tool > Options。在
Options 窗口中，展开 Program and Debug > Port Configuration，然后点击 MiniProg3 并选择图
3-8 中所示的设置内容。点击 Debug > Program，对开发板进行编程和供电。

注意：PSoC 4 Pioneer 套件中并不包含 CY8CKIT-002 MiniProg3。您可以从 赛普拉斯在线商店购买。

图 3-7.  使用 MiniProg3 对 PSoC 4 进行编程 / 调试

http://www.cypress.com/?rID=38154&source=shop
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图 3-8.  MiniProg3 配置

注意：有关使用 MiniProg3 进行编程的详细信息，请参考 PSoC Programmer 用户指南。

3.3 USB-UART 桥接器

板上的 PSoC 5LP 能够作为 USB-UART 桥接器，使 PSoC 4 和 PC 可以通过端口通信。 USB Mini-B
线缆被连接到 PSoC 4 Pioneer 套件上的 J10 时，名为 KitProg USBUART 的器件将显示在 Device
Manager 窗口中的 Ports （COM & LPT）内。有关 USB-UART 功能的更多信息，请参见第 66 页上
的将 PSoC 5LP 作为 USB-UART 桥接器使用 。

若要使用 COM 终端软件中的 USB-UART 功能，请 选择相应的 COM 端口作为通信端口，用于传送和
接收 COM 终端软件的数据。

PSoC 5LP 中的 UART 线被连接到插座 J8 的 P12[6]（J8_9）和 P12[7]（J8_10）引脚上。将插座 J8
上的 TX/RX 引脚连接到 PSoC 4 器件上的 RX 和 TX 引脚后，所建立的接口可用于对任何带有 UART
的 PSoC 4 设计进行数据传输。另外， UART 可以作为附加接口使用，以方便进行调试。该桥接器也
可以连接其他基于 UART 的外部器件。图 3-9 演示了 PSoC 5LP 和 PSoC 4 中 RX 和 TX 线之间的连
接。在该示例中，PSoC 4 UART 被路由到插座 J4 上，所以用户必须将 J8 上的 PSoC 5LP 的 RX/TX
线与之相连。

http://www.cypress.com/?rID=47002
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图 3-9.  PSoC 5LP 和 PSoC 4 中 RX 和 TX 线之间的连接示例 

表 3-2 列出了 USB-UART 桥接器所支持的协议。

表 3-2.  USB-UART 桥接器所支持的协议

参数 支持值

波特率 1200、 2400、 4800、 9600、 19200、 38400、 57600 以及 115200

数据位 8

奇偶校验 无

停止位 1

流控 无

支持的文件传输协议
Xmodem、1K Xmodem、Ymodem、Kermit 以及 Zmodem（仅适用于超过 2400
波特率的速度）。
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3.4 USB-I2C 桥接器

PSoC 5LP 还可以作为 USB-I2C 桥接器使用。 PSoC 4 通过 I2C 接口与 PSoC 5LP 进行通信，然后
PSoC 5LP通过USB线缆将数据传输给PC上的USB-I2C软件工具，即Bridge Control Panel（BCP）。

安装PSoC Programmer时，BCP也一起被安装。可以使用该软件进行发送或接收PSoC 5LP的USB-
I2C 数据。USB mini-B 型连接到 Pioneer 套件上的插座 J10 后，KitProg USB-I2C 器件将显示在 BCP
的 Connected I2C/SPI/RX8 Ports 中。

图 3-10.  桥接控制面板

要想使用 USB-I2C 功能，请选择 BCP 中的 KitProg USB-I2C。成功连接后，Connected 和 Powered
状态框将显示为绿色。
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图 3-11.  桥接控制面板中 KitProg USB-I2C 的连接情况

USB-I2C 由 PSoC 5LP 中的 USB 和 I2C 组件来实现。PSoC 5LP 的 SCL（P12_0）和 SDA（P12_1）
线分别连接着 PSoC 4 I2C 的 SCL （P3_0）和 SDA （P3_1）线。目前， USB-I2C 桥接器支持以下
I2C 速率：50 kHz、 100 kHz、 400 kHz 和 1 MHz。

有关创建具有 USB-I2C 桥接器功能的项目的信息，请参考第 79 页上的将 PSoC 5LP 作为 USB-I2C 桥
接器使用 。

3.5 更新板载编程器的固件

可以使用 PSoC 编程器来更新板载编程器和调试器的固件，即 PSoC 5LP 固件。当有新的固件或当
KitProg 固件被损坏时（请参见第 120 页上的固件运行状态 / 出错的 LED 指示 ），PSoC Programmer
将显示一个警报，指出有新的固件可用。 

依次选择 Start > All Programs > Cypress > PSoC Programmer< 具体版本号 >，可打开 PSoC 编
程器。 PSoC 编程器被打开时，将弹出 WARNING! 窗口，通知当前编程器固件需要更新。

图 3-12.  固件更新警报
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点击 OK 来关闭该窗口。关闭警告窗口后， Action and Results 窗口将显示：“Please navigate to
the Utilities tab and click the Upgrade Firmware button” （请导航到 Utilities 选项卡并点击 Upgrade
Firmware 按键）。

图 3-13.  更新 PSoC Programmer 中的固件信息

点击 Utilities 选项卡，然后点击 Upgarde Firmware 按键。成功升级后，Actions and Results 窗口
将显示包含了 KitProg 版本信息在内的固件更新信息。

图 3-14.  在 PSoC Programmer 中更新固件
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4.1 电路板的详细信息

PSoC 4 Pioneer 套件包含以下各模块：

■ PSoC 4

■ PSoC 5LP

■ 供电系统

■ 编程接口 （J6、 J7 — 未组装、 J10）

■ Arduino 兼容插座 （J1、 J2、 J3、 J4 以及 J12 — 未组装）

■ Digilent Pmod 兼容插座 （J5 — 未组装）

■ PSoC 5LP GPIO 插座 （J8）

■ Capsense 滑条

■ Pioneer 电路板 LED

■ 按键 （复位按键和用户按键）

图 4-1.  PSoC 4 Pioneer 套件的详细信息
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图 4-2.  PSoC 4 Pioneer 套件上引脚的映射情况 
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4.2 操作原理

本章节介绍的是 PSoC 4 Pioneer 套件的架构说明。

图 4-3.  框图

PSoC 4 是赛普拉斯的新一代可编程片上系统器件，用于嵌入式应用。它将可编程的模拟、数字逻辑，
可编程的输入 / 输出和高性能的 ARM Cortex-M0 子系统相结合。通过使用 PSoC 4，您可以方便的创
建外设组合，以满足应用的规范。

PSoC 4 Pioneer 套件拥有一个板上 PSoC 5LP 芯片，因此可以通过 USB 通信，使用串行线调试
（SWD）来编程和调试 PSoC 4。它还可以被用作 USB-I2C 桥接器和 USB-UART 桥接器运行。

Pioneer 套件具有一个 RGB LED、一个状态 LED 和一个电源 LED。将 RGB LED 连接到 PSoC 4，状
态 LED 则连接到 PSoC 5LP。更多信息，请参见 “ 状态 LED” 一节 第 120 页上的 A.5 固件运行状
态 / 出错的 LED 指示。该套件也有一个复位按键。该按键连接到 PSoC 4 XRES、用户按键和一个用
于开发基于触摸应用程序的 5 段 CapSense 滑条。各 PSoC 4 引脚被连接至该套件中的 J1- J4 插座
上，以支持 Arduino 扩展板。PSoC 5LP 引脚连接至插座 J8，以允许使用板上 PSoC 5LP 开发自定义
应用。

PSoC 4 Pioneer 套件可通过 USB Mini B、 Arduino 兼容插座或外部电源。低压差 （LDO）电压调节
器将输入电压调节为3.3 V。通过将跳线器插入到相配的电压选择插座VDD上，您可以选择使用VBUS
（5 V）或 3.3 V。
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4.3 功能描述

4.3.1 PSoC 4

该套件使用了 PSoC 4200 系列的器件。PSoC 4200 器件组合了具有可编程逻辑的微控制器、高性能
的模数转换、支持比较器模式的两个运算放大器以及通用的固定功能外设。更多有关信息，请参考
PSoC 4 网页和 PSoC 4200 系列的数据手册。

特性

■ 32 位 MCU 子系统
❐ 带有单周期硬件乘法器的 48 MHz ARM Cortex-M0 CPU
❐ 高达 32 KB 并带有读取加速器的闪存

❐ 最多支持 4 KB 的 SRAM
■ 可编程的模拟模块

❐ 两个运算放大器包括可重新配置的高驱动外部/高带宽内部驱动器、支持比较器模式和ADC输入
缓存功能。

❐ 12 位、1 Msps的 SAR ADC 包括差分模式和单端模式并且具有信号求平均功能的通道序列发生
器。

❐ 每个引脚均支持两个电流 DAC （IDAC），用于通用目的或电容式感应应用

❐ 两个低功耗比较器，可运行于深度睡眠模式
■ 可编程的数字模块

❐ 四个可编程的逻辑模块 （又称通用数字模块 UDB），每个模块包含 8 个宏单元和数据路径

❐ 赛普拉斯提供了外设组件库、用户定义的状态机以及 Verilog 输入

■ 低功耗模式下的工作电压为 1.71 ~ 5.5 V
❐ 支持 GPIO 引脚唤醒的 20 nA 停止模式

❐ 支持休眠和深度睡眠模式以实现唤醒时间与功耗之间的权衡。
■ 电容式感应 

❐ 赛普拉斯的电容式 Sigma-Delta 触摸感应（CSD）提供了一流的信噪比（SNR > 5:1）和耐水性

❐ 通过赛普拉斯提供的软件组件可以更容易地实现电容式感应设计
❐ 硬件自动调试 （SmartSense™）

■ 段式 LCD 驱动
❐ 所有引脚上都支持 LCD 驱动 （Com 或 Seg 驱动）

❐ 在深度睡眠模式下可运行，每个引脚占用 4 位内存

■ 串行通信
❐ 两个运行时可重新配置的独立串行通信模块 （SCB）可配置为 I2C、 SPI 或 UART 功能

■ 计时和脉宽调制
❐ 四个 16 位定时器 / 计数器脉冲宽度调制器 （TCPWM）模块

❐ 中心对齐模式、边缘模式和伪随机模式
❐ 基于比较器触发的停止 （Kill）信号可用于电机驱动以及其它可靠性较高的数字逻辑应用

■ 多达 36 个可编程的 GPIO
❐ 提供了 44 引脚 TQFP、 40 引脚 QFN 和 28 引脚 SSOP 等三种封装

❐ 所有 GPIO 引脚都可用作 CapSense、 LCD、模拟或数字引脚

❐ 可编程驱动模式、强度和转换速率
■ PSoC Creator 设计环境

❐ 集成开发环境 （IDE）提供了原理图输入和编译 （包括模拟和数字自动布线）

❐ 应用编程接口 （API）组件可用于所有固定功能和可编程的外设 
■ 行业标准软件的兼容性

❐ 输入原理图后，可以使用基于 ARM 的行业标准开发工具进行开发

有关详细信息，请参考 CY8C42 系列数据手册。

http://www.cypress.com/go/PSoC4
http://www.cypress.com/?rID=78632
http://www.cypress.com/?rID=78632
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4.3.2 PSoC 5LP

板上 PSoC 5LP 用于编程及调试 PSoC 4。 PSoC 5LP 通过 USB Mini B 连接到 PC 上的 USB 端口，
PSoC 5LP 还连接到 PSoC 4 的 SWD 接口。 

PSoC 5LP 是一个系统级解决方案，可在单芯片中提供微控制器单元（MCU）、存储器、模拟和数字
外设等功能。CY8C58LPxx 系列提供了一种开创性的方式来实现信号采集、信号处理和控制，并具有
准确度高、带宽大和灵活性高等特点。其模拟功能涵盖了广泛的信号范围，从热电偶信号（类似直流
电压）到超声波信号等。更多有关信息，请参考 PSoC 5LP 网站。

特性

■ 32 位 ARM Cortex-M3 CPU 内核

❐ 工作频率的范围介于 DC 至 67 MHz 之间

❐ 闪存程序存储器空间最大 256 KB， 100,000 次写循环、 20 年保留时间以及多种安全特性

❐ 高达 32 KB 闪存的纠错码 （ECC）或配置存储

❐ 最高可达 64 KB 的 SRAM

❐ 2 KB 可电擦除可编程只读存储器 （EEPROM）， 1M 的擦除周期以及 20 年数据保持时间

❐ 24 通道直接存储访问 （DMA）可对多层 AHB 总线进行访问

a. 可编程链式描述符和优先级

b. 支持高带宽 32 位传输

■ 低电压、超低功耗

❐ 宽工作电压：0.5 V 至 5.5 V

❐ 高效升压调节器 （0.5 V 输入， 1.8 V ~ 5.0 V 输出）

❐ 6 MHz 时的电流为 3.1 mA

❐ 低功耗模式包括：

a. 2 µA 睡眠模式，提供了实时时钟 （RTC）和欠压检测 （LVD）中断

b. 300 nA 休眠模式， RAM 保持数据

■ 多功能 I/O 系统

❐ 28 至 72 个 I/O （62 个 GPIO、 8 个 SIO 和 2 个 USBIO）

❐ 可从任意的 GPIO 连接到任意一个数字或模拟外设

❐ 所有 GPIO 均具有 LCD 直接驱动功能，最多能够驱动 46×16 段

❐ 所有 GPIO[3] 均支持 CapSense

❐ 1.2 V 至 5.5 V I/O 接口电压，多达 4 个电压域

❐ 所有引脚或端口都支持可屏蔽的独立 IRQ

❐ 带施密特触发器的 TTL 电平输入

❐ 所有的 GPIO 均可配置为开漏高 / 低电平、电阻上拉 / 下拉、高阻态或者强驱输出

❐ 在上电复位 （POR）时可配置 GPIO 引脚的状态

❐ SIO 具有 25 mA 的灌电流能力

■ 数字外设

❐ 20 至 24 个基于可编程逻辑器件 （PLD）的通用数字模块 （UDB）

❐ 全速 CAN 2.0b 接口， 16 个 RX 缓冲区， 8 个 TX 缓冲区

❐ 12 Mbps 的全速 （FS） USB 2.0 （采用内部振荡器）

❐ 4 个 16 位可配置定时器、计数器和 PWM 模块

❐ 67 MHz、24 位固定点的数字滤波器模块（DFB），用于实现有限脉冲响应（FIR）和无限脉冲
响应 （IIR）滤波器

❐ 标准外设库

a. 8、 16、 24 和 32 位定时器、计数器和 PWM

b. 串行外设接口 （SPI）、通用异步发送接收器 （UART）、 I2C

http://www.cypress.com/go/PSoC5lp
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c. 目录中还提供了许多的其他外设

❐ 高级外设库

a. 循环冗余校验 （CRC）

b. 伪随机序列 （PRS）发生器

c. 本地互连网络 （LIN）总线 2.0 

d. 正交解码器

❐ 模拟外设 （1.71 V  VDDA  5.5 V）

❐ 在 –40 °C 到 +85 °C 范围内，内部参考电压为 1.024 V ±0.1% 

❐ 具有 8 至 20 位分辨率的可配置 Delta-Sigma 模数转换器 （ADC）

❐ 采样率最高可达 192 ksps

❐ 可编程增益级：×0.25 至 ×16

❐ 12 位模式、 192 ksps、 66 dB 信噪比和失真比 （SINAD）、 ±1 位 INL/DNL

❐ 16 位模式、 48 ksps、 84 dB SNR、 ±2 位 INL、 ±1 位 DNL

❐ 两个 SAR ADC， 12 位分辨率，最高 1 Msps 采样率

❐ 四个 8 位 8 Msps 电流 IDAC 或 1 Msps 电压 VDAC

❐ 四个响应时间为 95 ns 的电压比较器

❐ 四个驱动能力为 25 mA 的运算放大器

❐ 四个可配置的多功能模拟模块。配置示例包括可编程增益放大器 （PGA）、互阻放大器
（TIA）、混频器，以及采样和保持电路

❐ 支持 CapSense

■ 编程、调试和跟踪

❐ 支持 4 线 JTAG、 SWD、单线 SWV 以及 Traceport 接口

❐ Cortex-M3 闪存修补和断点 （FPB）模块

❐ Cortex-M3 Embedded Trace Macrocell™ （ETM™）可生成指令跟踪流

❐ Cortex-M3 数据观察点和跟踪 （DWT）可生成数据跟踪信息

❐ Cortex-M3 Instrumentation Trace Macrocell （ITM）可用于 printf 式调试

❐ DWT、 ETM 和 ITM 模块可通过 SWV 或 TRACEPORT 与片外调试和跟踪系统进行通信

❐ 支持通过 I2C、 SPI、 UART、 USB 以及其他接口进行引导加载程序编程

■ 高精度、可编程时钟

❐ 在整个温度和电压范围内， 内部振荡器的频率范围为 3 至 62 MHz

❐ 频率范围为 4 至 25 MHz 的晶振，能够实现晶振 PPM 精度

❐ 能够生成高达 67 MHz 的内部 PLL 时钟

❐ 32.768 kHz 时钟晶振

❐ 频率分别为 1 kHz、 33 kHz 和 100 kHz 的低功耗内部振荡器

更多信息，请参考 CY8C58LPxx 系列数据手册。 

http://www.cypress.com/?id=4076
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4.3.3 供电系统

该电路板支持多种形式的电源供电，输入的电源可以来自：

■ 使用板上 USB 编程插座 J10 的 5 V 电源 

■ 使用插座 J1_01 的 Arduino 扩展板的 5 V 至 12 V 电源 

■ 使用插座 J6 或 J7 的板上 SWD 编程的电源 — VTARG
■ VIN — J11

PSoC 4 和 PSoC 5LP 由电压为 3.3 V 或 5 V 的电源供电。通过 J9 跳线器，可以选用 3.3 V 或 5 V 的
电压。该电路板可以为输入 / 输出插座提供 3.3 V 和 5 V 的电压，并且接收来自输入 / 输出插座的 3.3
V 电压。外部电源可通过插座 VIN（J11）给该电路板供电；其中 VIN 的电压范围为 5 V 到 12 V。LDO
电压调节器将 VIN 值调制为 3.3 V。图 4-4 显示的是电源框图和保护电路。

注意： USB （VBUS）直接给 5 V 电域供电。因此，该电域的电压未经调节。

图 4-4.  电源框图和保护电路
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4.3.3.1 保护电路

该电路具有反向电压、过电压、短路和过电流保护等功能，如图 4-4 所示。

■ 通过肖特基二极管 （D1）可确保不会通过输入 / 输出插座给 5 V 的电域供电。 

■ 通过串接保护二极管 （D2）可确保不会通过 VIN （来自输入 / 输出插座的电源）供电给 USB。

■ 通过肖特基二极管 （D3）可确保不会通过输入 / 输出插座中的 3.3 V 电源供电给 LDO。

■ 通过保护二极管 （D4）可确保不可通过 VIN 将反向电压提供给电压调节器输入。

■ 通过与 PTC 恢复式保险丝相连接，可以避免计算机的 USB 端口发生短路和过电流情况。

■ 基于MOSFET的保护电路为 3.3 V电源导轨提供过电压和反向电压的保护。PMOS Q1可使电路板
组件免于发生反向电压情况。PMOS Q2 可使 PSoC 免于发生过电压情况。当电压超过 4.2 V 时，
PMOS Q2 将关闭以保护 PSoC 4。

■ 调整 LDO 的输出电压，使其考虑在肖特基二极管上的电压降，仍能提供 3.3 V 的电压。

4.3.3.2 测量 PSoC 4 电流消耗的流程

下列三种方法都用于测量 PSoC4 器件的电流消耗。

■ 当该电路板由 USB 端口 （J10）供电时，移除跳线器 J13 并连接一个电流表，如图 4-5 所示。

图 4-5.  由 USB 端口供电给 PSoC 4 时的电流测量 

■ 当同时使用 USB 和独立电源供电给 PSoC 4 电路板时（USB 上的电压调节器输出必须在独立电源
±0.5 V 的范围内）。 

❐ 去除跳线器 J13。将外部电源的正端连接到电流表的正端，并将该电流表的负端连接到跳线器

J13 的下面的引脚。图 4-6 显示了所需的连接。
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图 4-6.  单独供电给 PSoC 4 时的电流测量 

■ 单独供电给PSoC 4供，且未给PSoC 5LP供电时，为了避免测量电流时发生漏电情况，必须进行下
列操作：

❐ 移除零欧姆电阻 R24 及 R25。移除电阻的操作将会影响到 USB-I2C 的功能。

❐ 移除用于编程 PSoC 4 的 R11、 R15 和 R15。这样将禁用 PSoC 5LP 的编程功能。

❐ 使用一个电流表从插座 J13 的引脚 1 连接到它的引脚 2 进行测量电流。 

图 4-7.  零欧姆电阻的位置

4.3.4 编程接口

该套件允许在两种模式下对 PSoC 4 进行编程及调试：

■ 使用板上的 PSoC 5LP 编程器和调试器

■ 使用 CY8CKIT-002 MiniProg3 编程器和调试器 

VOLTAGE
SOURCE
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4.3.5 Arduino 兼容的插座（J1、 J2、 J3、 J4 及 J12 — 未组装）

该套件具有 5 个 Arduino 兼容的插座（J1、J2、J3、J4 及 J12）可以根据 Arduino 扩展板的硬件来开
发各种应用。

图 4-8.  Arduino 插座

J1 插座包含用于复位、内部参考电压 （IOREF）和电源线的输入 / 输出引脚。 J2 插座是一个模拟端
口。它包含用于 SAR ADC、比较器和运算放大器的输入 / 输出引脚。J3 主要作为一个数字端口使用。
它包含用于 PWM、I2C、SPI 和模拟参考的输入 / 输出引脚。J4 插座也是一个数字端口。它包含用于
UART 和 PWM 的输入 / 输出引脚。J12 是一个用于 SPI 接口的 Arduino ICSP 兼容插座。该插座未被
组装。有关插座器件编号的详细信息，请参考 第 121 页上的 A.6 材料表（BOM）章节中的 “ 未安装
组件 ” 部分的内容。

注意：PSoC 4 的引脚 P0[0] 被同时连接到 J2 插座的 13 引脚和 J4 插座的 5 引脚。同样， PSoC 4 的
引脚 P1[0] 被同时连接到 J2 插座的 17 引脚和 J4 插座的 7 引脚 。因此，当 P0[0]/P1[0] 在其中一个
J2 或者 J4 插座上被使用时，不可在另外的 J2 或者 J4 插座上将该引脚连接其他逻辑。
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图 4-9.  Arduino 兼容的插座

4.3.5.1 插座 J2 的其他功能

J2 插座是支持 Arduino 扩展板的一个 9x2 插座。PSoC 4 的端口 0、端口 1 和端口 2 的引脚被连接到
此插座。端口 1 引脚还可以使用 560 电阻与板上的 CapSense 滑条相连。如果没有使用 CapSense
功能，则需要移除这些电阻，从而保证这些引脚更好的性能。

Arduino 
Compatible 

I/O Header (J3)

Arduino 
Compatible 

I/O Header (J4)

Arduino 
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I/O Header (J1)
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4.3.5.2 未组装插座 J12 的功能

J12插座是一个支持Arduino扩展板的2 x 3插座。可在小的子集屏蔽上使用该插座，并且可以在PSoC
4 Pioneer 套件上未组装它。请注意， J12 插座只能在 5.0 V 模式下运行。为了保证屏蔽的正常功能，
需要确保在 5.0 V 模式下连接电源跳线器。

4.3.6 Digilent Pmod 兼容的插座（J5 — 未组装 )

该端口支持 Digilent Pmod 外设模块。Pmod 是小型的 I/O 接口，Pmod 端口通过 6 或 12 引脚连接器
连接至嵌入式控制电路板。 PSoC Pioneer 套件支持 6 引脚的 Pmod 类 2 （SPI）接口。有关 Digilent
Pmod 卡的详细信息，请参考 www.digilentinc.com 网页。

此插座在 PSoC 4 Pioneer 套件上未组装。连接 PMod 子卡之前，您需要组装好此插座。有关插座器
件编号的详细信息，请参考 第121页上的A.6 材料表（BOM）章节中的“未安装组件”部分中的内容。

图 4-10.  Pmod 连接

http://www.digilentinc.com
www.digilentinc.com
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图 4-11.  Digilent PMOD 接口

有关 J5 插座引脚说明的详细信息，请参见 第 116 页上的 A.2 引脚分配表。

4.3.7 PSoC 5LP GPIO 插座（J8）

PSoC 5LP 引脚中的一部分被连接到该插座。有关如何开发自定义应用的详细信息，请参考 第 88 页
上的 6.3 开发 PSoC 5LP 的应用程序。有关引脚的详细信息，请参考  第 116 页上的 A.2 引脚分配表 。

图 4-12.  PSoC 5LP GPIO 插座 （J8）
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4.3.8 CapSense 滑条

板上的套件具有 5 段线性的电容式触摸滑条。该触摸滑条连接到 PSoC 4 器件的引脚 P1[1]、P1[5]。 

Cmod （调制电容）被连接到引脚 P4[2]，并且可以选择和一个泄放电阻 （R1）进行连接。此板支持
具有防水性能的 CapSense 的设计。 

防水设计采用了一个概念为放置在传感器周围的导线屏蔽。必须将该屏蔽连接到器件上指定的屏蔽引
脚上，从而实现其功能。未使用时，需要将该屏蔽接地。在 PSoC 4 Pioneer 套件中，可分别使用电
阻 R44 和 R45 将该屏蔽连接到引脚上或接地。默认情况下， R45 被安装在连接屏蔽地的电路板上。
当评估防水设计时需要组装 R44。R44 会将屏蔽连接到指定的引脚，P0[1]。此屏蔽与 “Arduino 扩展
板 ” 不同（通过 Arduino 插座连接的电路板）。更多有关 CapSense 的详细信息，请参考 CapSense
设计指南。

图 4-13.  CapSense 滑条

图 4-14.  CapSense 滑条的连接
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4.3.9 Pioneer 电路板 LED

PSoC 4 Pioneer 套件具有 3 个 LED。绿色 LED（D10）用于指示编程器的状态。有关 LED 指示列表
的详细信息，请参考 A.5 固件运行状态 / 出错的 LED 指示 。一个琥珀色的 LED（D3）用于指示电路
板的电源供电状态。套件还有一个用于用户应用场合的通用三色 LED（D9），它被连接至 PSoC 4 的
特定引脚。

图 4-15 显示了这些 LED 在电路板上的位置。图 4-16 和图 4-17 介绍了有关 LED 原理图的详情。

图 4-15.  Pioneer 套件 LED

图 4-16.  状态 LED 和电源 LED

图 4-17.  RGB 三色 LED

P5LP3_1

P5LP_VDD

0805

R31
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0805
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2 1

VDD
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Power LED

2 1
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P4_VDD R G

B

D9

RGB LED

1

2 3

4
R29 1.5K

R30 1.5K

R28 2.2K
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4.3.10 按键

该套件包括一个复位按键和一个用户按键，如图图 4-18 所示。

复位按键被连接到 PSoC 4 上的 XRES 引脚，用于复位 PSoC 4 的板上器件。用户按键被连接到 PSoC
4 器件的 P0[7]。在工作模式下，如低电平有效模式，上述的两个按键都接地。

图 4-18.  按键

USER BUTTON

RESET

/XRES

P0_7

SW2

EVQ-PE105K

1 2

SW1

EVQ-PE105K

1 2



CY8CKIT-042 PSoC® 4 Pioneer 套件指南， 文档编号：001-90179 版本 *B 47

5. 示例代码

本章节中描述的示例代码介绍了 PSoC 4 器件和板上组件的功能。要访问这些示例，请从网页下载 CD
ISO 镜像并安装各种文件。示例代码在安装位置的固件文件夹内提供。要想获取 PSoC Creator 中所

有示例代码的完整列表，请访问 PSoC 3/4/5 示例代码网址。

请按照下面步骤来打开和编程示例代码：

1. 从 Start 菜单中启动 PSoC Creator。

2. 通过点击 Examples and Kits > Find Example Project > Kits > CY8CKIT-042 下面的

<Project.cywrk> 打开示例代码。

图 5-1.  从 PSoC Creator 打开示例代码

http://www.cypress.com/go/CY8CKIT-042
http://www.cypress.com/?rID=101641
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3. 依次选择 Build > Build <Project name> 来编译示例代码，并生成十六进制文件。

图 5-2.  使用 PSoC Creator 编译项目

4. 使用连接至端口 J10 的 USB 线缆将电路板连接至计算器以进行编程，如第 23 页上的 3.2 对
PSoC 4 进行编程和调试 所示。该电路板被识别为 KitProg。

5. 从 PSoC Creator，点击 Debug > Program 。

图 5-3.  使用 PSoC Creator 对器件进行编程

6. 如果还没获取器件， PSoC Creator 将打开编程窗口。选择 KitProg/ 并点击 Port Acquire （端口

获取）按键。

图 5-4.  从 PSoC Creator 中获取器件
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7. 拿到器件后，它将显示在 KitProg 下的树形结构中。现在，点击 Connect 按键。

图 5-5.  从 PSoC Creator 连接器件

8. 点击 OK，退出该窗口并开始编程。

图 5-6.  使用 PSoC Creator 对器件进行编程 
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5.1 项目：使 LED 闪烁发光

5.1.1 项目描述

该示例使用一个脉冲宽度调制器（PWM）来点亮 RGB LED。将 PWM 输出连接至 RGB LED 的引脚

P0_3 （蓝色）。闪烁频率为 1 Hz，占空比为 50%。通过分别改变周期和比较值可以更改闪烁频率和

占空比。

注意：在该示例中， PSoC 4 Pioneer 套件保持默认设置。

图 5-7.  闪烁 LED 项目的 PSoC Creator 原理图设计

5.1.2 硬件连接

由于所有连接均为电路板上的固定连线，所以该项目不要求进行任何额外的硬件连接。在工作区浏览
器中打开 Blinking LED.cydwr，然后选择合适的引脚。

图 5-8.  为闪烁 LED 项目选择引脚

表 5-1.  引脚连接

引脚名称 端口名称

Pin_BlueLED P0_3 （蓝色）
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5.1.3 流程图

图 5-9 显示的是在 main.c 中执行代码的流程图。

图 5-9.  闪烁 LED 项目的流程图

5.1.4 验证输出

编译并烧写示例目标代码到器件中。观察闪烁 LED 的频率和占空比。在 PWM 组件内更改周期值和比

较值，如图 5-10 所示。对该器件进行重新编译和重新编程，以更改频率和占空比。

图 5-10.  PWM 组件配置窗口
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5.2 项目：PWM

5.2.1 项目描述

该示例代码演示了 PWM 组件的使用情况。该项目使用三个 PWM 输出来设置 Pioneer 套件上 RGB
LED 的颜色。 LED 的颜色周期经过七种颜色 — 紫色 > 靛蓝色 > 蓝色 > 绿色 > 黄色 > 橙色 > 红色

（VIBGYOR）。每一种颜色将保持一秒的时间。通过更改 PWM 的脉冲宽度可以获取不同的颜色。

图 5-11.  PWM 项目的 PSoC Creator 原理图设计

5.2.2 硬件连接

由于所有连接均为电路板上的固定连线，所以该项目不要求进行任何额外的硬件连接。在工作区浏览
器中打开 PWM.cydwr，然后选择合适的引脚。

图 5-12.  为 PWM 项目选择引脚

表 5-2.  引脚连接

引脚名称 端口名称

Pin_RedLED P1_6 （红色）

Pin_GreenLED P0_2 （绿色）

Pin_BlueLED P0_3 （蓝色）
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5.2.3 流程图

图 5-13 显示的是在 main.c 中执行代码的流程图。

图 5-13.  PWM 项目流程图 

5.2.4 验证输出

编译并编程示例代码，然后复位器件。通过颜色格式观察 RGB LED 周期。



CY8CKIT-042 PSoC® 4 Pioneer 套件指南， 文档编号：001-90179 版本 *B 54

示例代码

5.3 项目：深度睡眠

5.3.1 项目描述

该项目演示了 PSoC 4 的低功耗功能。LED 在一秒内发亮以表示活动模式，然后该器件将进入深度睡

眠模式。按下 SW2 开关可唤醒器件，并且 LED 在一秒内将从发亮然后返回到深度睡眠模式。

图 5-14.  深度睡眠项目的 PSoC Creator 原理图设计

5.3.2 硬件连接

由于各连接为电路板上的固定连线，所以该项目不要求进行任何额外的连接。要想使用该项目进行低
功耗测量，请参考第 38 页上的 4.3.3.2 测量 PSoC 4 电流消耗的流程 中介绍的使用情况。 

在工作区浏览器中打开 Deep Sleep.cydwr，然后选择合适的引脚。

表 5-3.  引脚连接

图 5-15.  为深度睡眠项目选择引脚

引脚名称 端口名称

Pin_RedLED P1_6 （红色）

Pin_WakeUpSwitch P0_7
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5.3.3 流程图

图 5-16 显示的是在 main.c 中执行代码的流程图。

图 5-16.  深度睡眠项目流程图

5.3.4 验证输出

编译并编程示例代码，然后复位器件。LED 在一秒中打开然后关闭，以表示该器件已经进入深度睡眠

模式。通过按下 SW2 开关从深度睡眠模式唤醒器件，然后进入活动模式。经过一秒后，该器件返回

睡眠状态。

注意：当器件进入深度睡眠模式时，在开始编程前，编程器必须重新获取器件。

Start

Turn LED on 
for one second

Enter Deep-
Sleep mode

Interrupt on 
SW2 press

Clear the 
interrupt
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5.4 项目：CapSense

该示例代码有两种执行方法 — 使用或者不使用 CapSense 调试。凭借 PSoC Creator 中的调谐器助手

GUI，可以使用相同的项目来演示 CapSense 功能和 CapSense 调试。通过注释和取消注释示例代码

的 main.c 文件中的 #define ENABLE_TUNER 行，可以实现该操作。当 #define 语句被注释 （/
*…… */ 或 //）时，PSoC Creator 将不编译 #ifdef（若定义）语句下面的代码。类似的，当 #define
语句不被注释，调谐器 GUI 需要的代码将被编译。默认情况下，通过注释 #define，将该项目设置

为在无 CapSense 调试的情况下工作。

5.4.1 CapSense （无调试）

5.4.1.1 项目描述

该示例代码演示了 PSoC 4 上的 CapSense。该示例使用电路板上的五段 CapSense 滑条。通过使用

在 CapSense 组件中实现的赛普拉斯 CapSense Sigma Delta （CSD）算法对滑条上的电容传感器进

行扫描。该项目被预调，以处理该电路板的寄生电容。更多有关 CapSense 组件和 CapSense 调试的

信息，请参考 PSoC Creator 中的 CapSense 组件数据手册。

在该示例代码中，绿色和红色 LED 的亮度按照用户手指在 CapSense 滑条上触摸的位置而变化。

图 5-17.  CapSense 项目的 PSoC Creator 原理图设计

注意：禁用调试功能时， EzI2C 组件不被使用。
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5.4.1.2 硬件连接

由于所有连接均为电路板上的固定连线，所以该项目不要求进行任何额外的硬件连接。在工作区浏览
器中打开 CapSense.cydwr，然后选择合适的引脚。

注意：禁用调试功能时， I2C 通信行不被使用。

图 5-18.  为 CapSense 项目选择引脚

表 5-4.  引脚连接

引脚名称 端口名称

CapSense:Cmod P4_2

CapSense:Sns[0] P1_1

CapSense:Sns[1] P1_2

CapSense:Sns[2] P1_3

CapSense:Sns[3] P1_4

CapSense:Sns[4] P1_5

Pin_GreenLED P0_2 （绿色）

Pin_RedLED P1_6 （红色）

EZI2C_1:scl P3_0 (SCL)

EZI2C_1:sda P3_1 (SDA)
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5.4.1.3 流程图

图 5-19 显示的是在 main.c 中执行代码的流程图。

图 5-19.  CapSense 项目流程图 

5.4.1.4 验证输出

绿色和红色 LED 的亮度按照用户手指在 CapSense 滑条上触摸的位置而变化。当手指在滑条的第 5 段

（P1[5]）上触摸时，绿色 LED 比红色 LED 更亮；当手指在滑条的第 1 段 （P1[1]）上触摸时，红色

LED 比绿色 LED 更亮。
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5.4.2 CapSense （有调试）

5.4.2.1 项目描述

该示例代码演示了如何在 PSoC 4 上使用 “ 调谐器 ” 来监控 CapSense 输出。在调谐器 GUI 上可以

监控各种 CapSense 输出，如原始计数、基准线和信号（差值计数）。该项目采用自动调试功能，通

过该功能可以自动设置所有 CapSense 参数为最佳值。在 GUI 中可以监控参数设置项，但不能对其进

行任何更改。在手动调试方法中，可以更改 GUI 中的参数设置并可以查看结果输出。

该示例代码使用电路板上的五段 CapSense 滑条。通过使用在 CapSense 组件中实现的赛普拉斯

CapSense Sigma Delta （CSD）算法对滑条上的电容传感器进行扫描。该代码使用调谐器 API。在

主循环中，调谐器 API CapSense_TunerComm() 用于扫描传感器；该调谐器还可通过 I2C 通信接口

将 CapSense 变量原始计数、基准线和差值计数 （信号）发送给 PC GUI。

在该示例中，绿色和红色 LED 的亮度按照用户手指在 CapSense 滑条上触摸的位置而变化。

有关项目原理图的信息，请参考图 5-17。

5.4.2.2 硬件连接

由于所有连接均为电路板上的固定连线，所以该项目不要求进行任何额外的硬件连接。在工作区浏览
器中打开 CapSense.cydwr，然后选择合适的引脚。

有关 CapSense 项目引脚连接的信息，请参考表 5-4 和图 5-18。

5.4.2.3 流程图

图 5-20.  CapSense （有调试）流程图

Start

Initialise and start the 
PWM and CapSense 

Tuner

Start Tuner 
communication

Get the finger position on 
the slider

Set the PWM output width to 
adjust the brightness of the 

RGB LED
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5.4.2.4 启动调谐器 GUI

需要启动和运行 PSoC Creator 中的调谐器 GUI，以运行示例代码。请按照下面各步骤启动 GUI：

1. 打开项目的 TopDesign.cysch 文件。

图 5-21.  顶层设计文件

2. 要打开调谐器，请右键点击 PSoC Creator 中的 CapSense_CSD 组件，然后点击 Launch Tuner
（启动调谐器）。

图 5-22.  启动调试器
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3. 调谐器 GUI 打开。点击 Configuration （配置），以打开配置窗口。

图 5-23.  调试器 GUI

4. 设置 I2C 通信参数，如下图所示。

图 5-24.  I2C 通信

5. 点击 OK 按键，以保存设置的内容。
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5.4.2.5 验证输出

1. 要想开始执行扫描和通信，请点击 Start。

图 5-25.  开始通信
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2. 在 Tuning （调试）选项卡中选择某个传感器。所选定的传感器上会有一个红色边框标志。

各 CapSense 参数位于右下角的 Sensor Properties （传感器属性）选项卡上。您不能编辑这些设

置项，因为该项目使用了 “ 自动调试 ” ；该功能会自动设置所有参数。触摸选定的传感器，并观
察调谐器窗口的响应。

注意：该电路板是根据 CapSense 最佳实践（1.5 mm 厚覆盖层）的布局指南设计的。因此，建议

您在使用 CapSense 示例代码进行调试时使用覆盖层 （并不包含在本套件中）。

图 5-26.  传感器调试

3. 在 Graphing （绘图）选项卡中，每个传感器的 CapSense 数据 （原始计数、基准线、差值计数

（信号）以及 On/Off 状态都是以图形显示的。点击右下角的 Graphing Properties 选项卡，为显

示于 Graphing 选项卡上的 CapSense 数据选择滑条元素。
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4. 按照下图选择想要观察的传感器。选定参数的图形将被显示。

图 5-27.  传感器参数图形
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5. 触摸传感器或滑条元素，并查看原始计数的增量。

图 5-28.  原始计数增加
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6. 进阶主题

6.1 将 PSoC 5LP 作为 USB-UART 桥接器使用

PSoC 5LP 用作为 USB-UART 桥接器可以和 COM 终端软件进行通信。该部分说明了如何创建一个

PSoC 4 示例代码，用于同 COM 终端软件进行通讯。PSoC 4 Pioneer 套件中的该项目及其他示例代

码都位于 element14 网页上， 100 个项目在 100 天内。 

如果用户使用了不包含 HyperTerminal 配置的 Windows 操作系统，那么，可采用备用的终端软件，

如 PuTTY。

1. 在 PSoC Creator 中创建 PSoC 4 的新项目。为您的项目选择合适的位置，并根据需要重新命名它。

图 6-1.  在 PSoC Creator 中打开新项目 

http://www.element14.com/community/message/75417#75417/l/100-projects-in-100-days
http://www.putty.org/
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2. 将 UART （SCB）组件拖放到顶层设计内。 

图 6-2.  组件目录中的 UART 组件 

3. 要想配置 UART，请双击该组件或右键点击它并选择 Configure （配置）。

图 6-3.  打开 UART 配置窗口
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4. 配置 UART，如下面各个图片所示。

图 6-4.  UART 配置窗口

图 6-5.  UART Basic 配置窗口 
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图 6-6.  UART Advanced 配置窗口 

5. 依次点击 Apply > OK 以保存已实现的 UART 配置。

6. 在 <Project.cydwr> 的 Pin 选项卡下，分别为 UART RX 和 UART TX 选择 P0[4] 和 P0[5] 引脚。 

图 6-7.  引脚选择 
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7. 将以下代码放入您的 main.c 项目文件内。代码将回送所接收的所有 UART 数据。 

int main()
{   
    uint8 ch;

    /* Start SCB UART TX+RX operation */    
    UART_Start(); 
    
/* Transmit String through UART TX Line */
UART_UartPutString("CY8CKIT-042 USB-UART");

    for(;;)
    {
        /* Get received character or zero if nothing has been received yet 
*/
        ch = UART_UartGetChar(); 

        if(0u != ch)
        {
 /* Send the data through UART. This functions is blocking and waits until 
there is an entry into the TX FIFO. */
            UART_UartPutChar(ch);
        }
    }
}
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8. 通过依次选择 Build > Build {Project Name} 或按下组合键 [Shift] + [F6]，可以编译项目。项目建

立无误或无警告后，通过 PSoC 5LP USB 编程器或 MiniProg3，（依次点击 Debug > Program）

将该项目编程到 PSoC 4 内。

将 PSoC 4 上的 RX 线连接到 J8_10，并将 PSoC 4 的 TX 线连接到 J8_9，如下图所示。

图 6-8.  PSoC 4 与 PSoC 5LP 之间的 UART 连接

图 6-9.  PSoC 4 与 PSoC 5LP 之间的 UART 连接框图 

注意：根据 UART 组件的配置情况，可将 UART RX 和 UART TX 路由到 PSoC 4 上的任意数字引脚。

通过 UART 的 SCB 执行，可将 RX 和 TX 引脚路由到下面任何一个子集：（P0[4]、P0[5]）、（P3[0]、
P3[1]）或 （P4[0]、 P4[1]）。

PSoC 5LP PSoC 4
USB 

Mini B

P0[4]
UART RX

P0[5]
UART TX

D+

D-

P15[6]

P15[7]

J8_10J8_9

P12[7]
UART TX

P12[6]
UART RX



CY8CKIT-042 PSoC® 4 Pioneer 套件指南， 文档编号：001-90179 版本 *B 72

进阶主题

要想 COM 终端软件同 PSoC 4 通信，请按照以下流程进行操作：

9. 将 USB Mini B 连接到 J10。该套件将枚举为 KitProg USB-UART，并显示在 Device Manager（器

件管理程序）的 Ports (COM & LPT) 中。并将一个通信端口分配给 KitProg USB-UART。

图 6-10.   Device Manager 中的 KitProg USB-UART 
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2. 打开 HyperTerminal 并依次选择 File > New Connection，然后输入新连接的名称，最后点击 OK。

对于 PuTTY，双击 PuTTY 图标并选择 Connection 下的 Serial （串行）项。

图 6-11.  打开新连接

HyperTerminal

PuTTY
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3. 一个新窗口被打开，可在这里选择通信端口。

在 HyperTerminal 对话框中，选择 ‘Connect using’ 框中的 COMX （或分配给 KitProg USB-
UART 的特定通信端口），然后点击 OK。

在 PuTTY 配置中 Serial line to connect to （连接的串行线）项旁边的文本框内键入 COMX。

该示例代码使用了 COM12。

图 6-12.  选择通信端口 

HyperTerminal

PuTTY
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4. 在 HyperTerminal 配置中，分别选择 Port Settings （端口设置）标签下的 ‘Bits per 
second’、‘Data bits’、‘Parity’、‘Stop bits’ 以及 ‘Flow control’ 相应的设置，然后点
击 OK。

请确保该设置与 PSoC 4 中所配置的 UART 设置相同。

在 PuTTY 的 Configure the serial line （配置串行线）下，分别为 ‘Speed (baud)’、‘Data
bits’、‘Stop bits’、‘Parity’ 以及 ‘Flow control’ 选择相应的设置。在 Connection type
（连接类型）下点击 Session 并选择 Serial 项。 

Serial line 显示的是所选定的通信端口（COM12）， Speed 显示的是所选的波特率。点击 Open
以启动通信过程。

图 6-13.  配置通信端口

HyperTerminal

PuTTY
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图 6-14.  在 PuTTY 中选择通信类型

5. 依次选择 File > Properties > Settings > ASCII Setup 后，通过使能 Echo typed characters
locally，可以在超级终端中显示所输入的字符。在 PuTTY 中，使能 Terminal > Line discipline
选项下的 Force on，可显示在 PuTTY 中所输入的字符。

图 6-15.  使能在 HyperTerminal 中所输入字符的回送
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图 6-16.  使能在 PuTTY 中所输入字符的回送

6. COM 终端软件显示了来自 PSoC 4 中 UART 的键入数据和回环数据。

图 6-17.  HyperTerminal 上所显示的数据 
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图 6-18.  PuTTY 上所显示的数据 
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6.2 将 PSoC 5LP 作为 USB-I2C 桥接器使用

将 PSoC 5LP 作为一个 USB-I2C 桥接器使用，通过该桥接器可以同运行在 PC 上的 USB-I2C 软件进

行通信。 PSoC 4 Pioneer 套件中的该项目及其他示例代码都位于 element14 网页上， 100 个项目在

100 天内。

下述各步骤说明了如何使用 USB-I2C 桥接器，通过该桥接器可以在 BCP 与 PSoC 4 器件间进行通信。

1. 在 PSoC Creator 中创建面向 PSoC 4 的新项目。

图 6-19.  在 PSoC Creator 中打开新项目 

http://www.element14.com/community/message/75417#75417/l/100-projects-in-100-days
http://www.element14.com/community/message/75417#75417/l/100-projects-in-100-days
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2. 将一个 I2C 组件拖放到 TopDesign 内。

图 6-20.  组件目录中的 I2C 组件 

3. 要想配置 I2C 组件，请双击该组件或右键点击它并选择 Configure。

图 6-21.  打开 I2C 配置窗口
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4. 按照下面介绍的设置对 I2C 进行配置。

图 6-22.  I2C Configuration 选项卡



CY8CKIT-042 PSoC® 4 Pioneer 套件指南， 文档编号：001-90179 版本 *B 82

进阶主题

图 6-23.  I2C Basic 选项卡

图 6-24.  I2C Advanced 选项卡 
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5. 依次选择 Apply > OK 以保存所进行的更改。

6. 在 <poject.cydwr> 的 Pin 选项卡中分别为 I2C SCL 和 I2C SDA 选择 P3[0] 和 P3[1] 引脚。

图 6-25.  引脚选择 

7. 将以下代码放入您的 main.c 项目文件内。该代码允许在 PSoC 4 器件与 BCP 应用之间发送和接收

I2C 数据。

int main()
{

uint8 wrBuf[10];  /* I2C write buffer */
uint8 rdBuf[10];  /* I2C read buffer */
uint8 indexCntr;
uint32 byteCnt;

/* Enable the Global Interrupt */
CyGlobalIntEnable;

/* Start I2C Slave operation */
I2C_Start();

/* Initialize write buffer */
I2C_I2CSlaveInitWriteBuf((uint8 *) wrBuf, 10);

/* Initialize read buffer */
I2C_I2CSlaveInitReadBuf((uint8 *) rdBuf, 10);

for(;;) /* Loop forever */
{

/* Wait for I2C master to complete a write */
if(0u != (I2C_I2CSlaveStatus() & I2C_I2C_SSTAT_WR_CMPLT))
{

/* Read the number of bytes transferred */
byteCnt = I2C_I2CSlaveGetWriteBufSize();

/* Clear the write status bits*/
I2C_I2CSlaveClearWriteStatus();

/* Move the data written by the master to the read buffer so that the 
master can read back the data */
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for(indexCntr = 0; indexCntr < byteCnt; indexCntr++)
{

rdBuf [indexCntr] = wrBuf[indexCntr]; /* Loop back the data to the read 
buffer */

}

/* Clear the write buffer pointer so that the next write operation will 
start from index 0 */
I2C_I2CSlaveClearWriteBuf();

/* Clear the read buffer pointer so that the next read operations starts 
from index 0 */
I2C_I2CSlaveClearReadBuf();

}
/* If the master has read the data , reset the read buffer pointer to 0 
and clear the read status */
if(0u != (I2C_I2CSlaveStatus() & I2C_I2C_SSTAT_RD_CMPLT))
{
/* Clear the read buffer pointer so that the next read operations starts 
from index 0 */

I2C_I2CSlaveClearReadBuf();

/* Clear the read status bits */
I2C_I2CSlaveClearReadStatus();

}
}

}

6. 通过依次点击 Build > Build Project 或按组合键 [Shift]+[F6]，可以构建项目。编译项目无误或没

有发生警告后，通过 PSoC 5LP 编程器或 MiniProg3，（按下组合键 [Ctrl] +[F5] 实现）将该代码

加载到 PSoC 4 内。

7. 依次选择 Start > All Programs > Cypress > Bridge Control Panel <version number>，打开

BCP。

8. 连接到 Connected I2C/SPI/RX8 Ports 下的 KitProg/。
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图 6-26.  连接到 BCP 中的 KitProg/

9. 从 Tools 菜单中打开 Protocol configuration，然后选择相应的 I2C Speed。请确保该 I2C 速度

与 I2C 组件中所配置的速度相同。点击 OK，关闭该窗口。

图 6-27.  打开 BCP 中的协议配置窗口
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10. 从 BCP 将来自五个数据字节发送到 I2C 器件 （从设备地址为 0x08）。记录显示了此传输操作是

否成功。每个字节后显示的 ‘+’ 指示表示传输操作已成功，而 ‘–’ 指出传输操作失败。

图 6-28.  在 BCP 中输入指令 
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图 6-29.  BCP 中的 NACK 指示 

11.  从 BCP 读取来自 I2C 从设备的五个数据字节 （从设备地址为 0x08）。记录显示了此传输操作是

否成功。

图 6-30.  从 BCP 中读取数据字节

注意：请参见 BCP 中 Help 下的 Help Contents （帮助内容）或按下 [F1]，了解 I2C 指令的细节。



CY8CKIT-042 PSoC® 4 Pioneer 套件指南， 文档编号：001-90179 版本 *B 88

进阶主题

6.3 开发 PSoC 5LP 的应用程序

PSoC 4 Pioneer 套件具有一个板上 PSoC 5LP，其主要功能是作为编程器和桥接器使用。用户可以使

用 PSoC 5LP 来编译普通项目或者可引导加载项目。

图 6-31 汇总了 Pioneer 电路板上的 PSoC 5LP连接。J8 是 I/O 连接器（请参考 4.3.7 PSoC 5LP GPIO
插座（J8）章节）。已连接 USB（J10），并作为 PC 接口使用。然而，您仍可以使用该 USB 连接创

建自定义的 USB 设计。 

编程插头（J7）用于独立编程目的。需要焊接该插头。请参考 第 121 页上的 A.6 材料表（BOM）中

的 “ 无负载组件 ” 章节。

图 6-31.  PSoC 5LP 模块框图

6.3.1 为 PSoC 5LP 编译可引导加载项目

所有 PSoC 5LP 的可引导加载应用程序需要适合已经编程在板上的 Bootloader 十六进制文件。

Bootloader 的十六进制文件可在套件文件中获得，或可从套件网页下载。

十六进制文件位于以下套件安装程序目录中： 
<Install_Directory>\CY8CKIT-042 PSoC 4 Pioneer Kit\ 
<version>\Firmware\Programmer\KitProg_Bootloader 

图 6-32.  KitProg Bootloader 十六进制文件的位置
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I/O Header
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10-pin SWD 
programming 

and debugging 
header
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www.cypress.com/go/CY8CKIT-042
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要想编译 PSoC 5LP 的可引导加载应用，请按照以下步骤进行操作：

12.在 PSoC Creator 中依次选择 New > Project 并点击 PSoC 5LP Design ；在 Device 框的下拉列

表中选择 Launch Device Selector，这时将出现 Select PSoC 5LP Device 窗口，请选择

CY8C5868LTI-LP039 项，如图 6-33 中所示。点击 OK。

图 6-33.  在 PSoC Creator 中打开新项目 
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图 6-34.  在 PSoC Creator 中选择器件 

13.导航到原理图窗口并将可引导加载组件拖放到顶层设计内。

图 6-35.  组件目录中的可引导加载组件 
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通过选择配置窗口中的 Dependencies 选项卡并点击 Browse 按键，可以设置可引导加载组件的依赖

性属性。选择 KitProg_Bootloader.hex 和 KitProg_Bootloader.elf 文件；然后点击 Open （打开）。

图 6-36.  可引导加载组件的配置窗口

图 6-37.  选择 KitProg Bootloader Hex 文件 
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图 6-38.  选择 KitProg Bootloader Elf 文件

3. 在 General 选项卡中勾选 Manual application image placement 复选框，并将 Placement
address 设置为 “0x00002800”，如图 6-39 所示。

图 6-39.  可引导加载组件的 “General” 选项卡 

4. 开发您的自定义项目。 
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5. 可引导加载项目的 NVL 设置必须与 KitProg_Bootloader 项目的相同。下图显示了

KitProg_Bootloader.cydwr 系统的设置情况。 

图 6-40.  KitProg Bootloader 系统设置 

6. 通过依次选择 Build > Build Project 或按组合键 [Shift]+[F6]，可以编译所需的项目。

7. 要想将该项目下载到 PSoC 5LP 器件上，请打开 PSoC Creator 中的 Bootloader 主机工具 。依次

选择 Tools > Bootloader Host。

图 6-41.  从 PSoC Creator 打开 Bootloader 主机工具 

8. 按住复位开关 （SW1），同时插上 USB Mini-B 连接器。若按住开关的时间超过 100 ms， PSoC
5LP 将进入 Bootloader 模式。拨掉 PSoC 4（J13）的供电跳线器并将 USB Mini-B 连接器插到 J10
插头上时， PSoC 5LP 也会进入 Bootloader 模式。
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9. 在 Bootloader Host 工具中，点击 Filters （滤波器）并添加一个过滤器，以识别 USB 器件。

分别将 VID 和 PID 设置为 0x04B4 和 0xF13B，然后点击 OK。

图 6-42.  Bootloader Host 工具中的 Port Filters 选项卡 

10.在 Bootloader Host 工具中点击 Open File（打开文件）按键以浏览到可引导加载文件（*.cyacd）
所在的位置。

图 6-43.  在 Bootloader Host 工具中打开可引导加载文件 
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11.按下 Bootloader Host 工具中的 Program 按键便可对器件进行加载。 

图 6-44.  从 Bootloader Host 工具中选择 Bootloadable .cyacd 文件

12. 若引导加载成功，工具记录将显示 “Successful” ；如果引导加载失败，将显示 “Failed”，并

显示一条失败语句。

注意：

1. PSoC 5LP 的引脚被连接到 PSoC 5LP GPIO 插头 （J8）上。这些引脚用于支持高性能的模拟和

数字项目。有关引脚的详细信息，请参见 第 116 页上的 A.2 引脚分配表。

2. 当给自定义应用程序分配 PSoC 5LP 的引脚时，应特别注意。例如， P2[0]–P2[4] 是专用于编程

PSoC 4 的。在对引脚进行分配前，请参见 第 113 页上的 A.1 CY8CKIT-042 原理图中的

内容。

3. 当将某个普通项目编程到 PSoC 5LP 内时，该 PSoC 5LP 的初始功能（即作为编程器 /USB-UART
桥接器或 USB-I2C 桥接器使用）都不可用。

4. 除非自定义项目使用状态 LED，否则该状态 LED 不会工作。

更多有关Bootloader信息，请参见AN73503— 赛普拉斯PSoC3和PSoC 5LP的USB HID Bootloader
应用笔记。

http://www.cypress.com/?rID=57561
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6.3.2 编译 PSoC 5LP 的普通项目

普通项目是指在 CY8CKIT-042 中为 PSoC 5LP 器件创建的全新项目。在这里，将对 PSoC 5LP 上整

个闪存进行编程，包括覆盖所有的 Bootloader 和编程代码。要想恢复编程器，需要通过随套件安装程

序附带的出厂设置 KitProg.hex 文件重新编程 PSoC 5LP 器件。

可以在下面的地址中找到 KitProg.hex 文件： 
<Install_Directory>\CY8CKIT-042 PSoC 4 Pioneer Kit\<version>\Firm-
ware\Programmer\KitProg

该高级功能需要使用一个不属于此套件的 MiniProg3 编程器。可以在 www.cypress.com/go/CY8CKit-
002 网站上购买 MiniProg3。

要想为 PSoC 5LP 构建一个普通项目，请按照下列步骤进行操作：

1. 在 PSoC Creator 中依次选择 New > Project 并点击 PSoC 5LP Design 项；然后在 Device 框中

选择 CY8C5868LTI-LP039 （如图 6-45 所示），再点击 OK。

图 6-45.  在 PSoC Creator 中打开新项目 

2. 开发您的自定义项目

3. 通过依次选择 Build > Build Project 或按组合键 [Shift]+[F6]，可以编译所需的项目。

4. 将 MiniProg3 的 10 引脚连接器连接到板上的 10 引脚 SWD 调试和编程插头 J7 （需要填充的）。

5. 要想通过 PSoC Creator 编程 PSoC 5LP，请依次点击 Debug > Program 或按组合键 [Ctrl]+[F5]。
编程窗口将显示 MiniProg3 和项目 （CY8C5868LTI-LP039）中所选定的器件。

6. 先点击该器件再点击 Connect ，以进行编程。

www.cypress.com/go/CY8CKit-002
www.cypress.com/go/CY8CKit-002
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注意：

1. 板上默认并未焊接 10 引脚 SWD 调试和编程插头 （J7） 。更多有关信息，请参考 A.6 材料表

（BOM）中的 “ 未安装组件 ” 章节。

2. PSoC 5LP 的引脚被连接到 PSoC 5LP GPIO 插头 （J8）上。这些引脚用于支持高性能的模拟和

数字项目。有关引脚的详细信息，请参见 A.2 引脚分配表。

3. 当给自定义应用程序分配 PSoC 5LP 的引脚时，应格外注意。例如， P2[0]–P2[4] 是专用于编程

PSoC 4 的。在对引脚进行分配前，请参见 A.1 CY8CKIT-042 原理图中的内容。

4. 当将某个普通项目编程到 PSoC 5LP 内时，该 PSoC 5LP 的初始功能（即作为编程器 /USB-UART
桥接器或 USB-I2C 桥接器使用）都不可用。

5. 除非自定义项目使用状态 LED，否则该状态 LED 不会工作。

6.4 PSoC 5LP 出厂设置恢复说明

CY8CKIT-042 PSoC 4 Pioneer 套件包含一个带有出厂设置的 PSoC 5LP 器件。该器件可作为 PSoC
4 器件的板上编程器和调试器使用。

除了为 PSoC 4 器件创建应用程序外，用户亦可在本套件上创建 PSoC 5LP 器件的自定义应用程序。

请参考 第 88 页上的 6.3 开发 PSoC 5LP 的应用程序章节以更加了解详细信息。通过新的闪存映像重

新编程或引导加载PSoC 5LP器件时，出厂设置将被覆盖掉，同时会失去将PSoC 5LP器件作为PSoC
4 编程器 / 调试器使用的能力。要想恢复 PSoC 5LP 的出厂设置并使能编程器 / 调试器的功能，请执行

下面各操作。

6.4.1 使用可引导加载的应用程序编程 PSoC 5LP

若通过可引导加载应用程序编程 PSoC 5LP，用户可以使用以下某一个方法恢复出厂设置。

6.4.1.1 使用 PSoC 编程器恢复 PSoC 5LP 出厂设置

1. 从 Start > Cypress > PSoC Programmer 启动 PSoC Programmer 3.23.1 或更高版本。

2. 设置 Pioneer 套件进入服务模式。要进入该模式，当按住复位按键 （SW1 Reset）时，同时使用

所包含的 USB 电缆 （USB A 到 USB 微型 B）将 PSoC 4 Pioneer 套件连接到电脑。这样的操作

会使 PSoC 5LP 进入服务模式，闪烁状态的绿色 LED 表明进入该模式成功。
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3. 以下信息显示在 PSoC 编程器结果窗口中：“KitProg Bootloader device is detected”（已检测到

KitProg Bootloader 器件）。

图 6-46.  PSoC 编程器结果窗口

4. 切换到 PSoC 编程器窗口中的 Utilities 选项卡，并按下 Upgrade Firmware 按键。按下 Upgrade
Firmware 按键前，用户需要在 PC 端拔掉其他所有 PSoC 编程器（如 MiniProg3 和 DVKProg）。

图 6-47.  更新固件
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5. 编程完成后，将出现以下信息 “Firmware Update Finished at <time>”（固件更新在 < 时间 > 内

完成）。 

图 6-48.  固件更新完成

6. 用户已成功地恢复 PSoC 5LP 的出厂设置。它可作为 PSoC 4 器件上的编程器 / 调试器使用。

KitProg??2.03
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6.4.1.2 使用 USB Host 工具恢复 PSoC 5LP 的出厂设置

1. 从 Start > Cypress > PSoC Creator 启动 Bootloader Host 工具。

2. 使用 File > Open 菜单，加载 Kit Prog.cyacd 文件 （该文件同套件软件一起被安装）。该文件的

默认位置为：<Install_Directory>\CY8CKIT-042 PSoC 4 Pioneer Kit\<ver-
sion>\Firmware\Programmer\KitProg\KitProg.cyacd

图 6-49.  加载 KitProg.cyacd 文件
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3. 设置 Pioneer 套件进入服务模式。当按住复位按键 （“SW1 Reset”）时，使用随附提供的 USB
电缆 （USB A 转 Mini-B）将 PSoC 4 Pioneer 套件插入电脑。这样的操作会使 PSoC 5LP 进入服

务模式，其状态由闪烁状态的绿色 LED 显示。

4. 在 Bootloader Host 工具中，设置 USB 器件的滤波器，其中：VID 设为 04B4 ； PID 设为 F13B。
USB Human Interface Device 端口出现在端口列表中。通过点击选择该端口。

图 6-50.  选择 “USB Human Interface Device”

5. 点击 Program 按键 （或从菜单项依次选择 Actions > Program），将出场设置引导加载到 PSoC
5LP 上。

6. 编程完成后，会出现以下信息 “Programming Finished Successfully” （成功编程）。
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图 6-51.  成功编程

7. 用户已成功地恢复 PSoC 5LP 的出厂设置。它可作为 PSoC 4 器件上的编程器 / 调试器使用。

6.4.2 使用标准的应用程序编程 PSoC 5LP

若使用标准的应用编程 PSoC 5LP，那么，用户可以通过以下方法恢复出厂设置。

1. 从 Start > Cypress > PSoC Programmer 启动 PSoC Programmer 3.23.1 或更高版本。 

2. 通过依次选择 File > Open 菜单加载随该套件附带的十六进制 KitProg.hex 出厂设置文件。该文件

的默认位置为：<Install_Directory>\CY8CKIT-042 PSoC 4 Pioneer Kit\<ver-
sion>\Firmware\Programmer\KitProg

3. 将 CY8CKIT-002 MiniProg3（单独销售）连接到计算机。将 MiniProg3 的 10 引脚连接器电缆插入

到插头 [J7] 内。请注意，插头 J7 默认没有焊接安装。更多信息，请查考 第 121 页上的 A.6 材料表

（BOM）。

http://www.cypress.com/go/CY8CKIT-002
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4. 请确保在 PSoC Programmer 中选定 MiniProg3 端口和 10 引脚连接器（10p 选项），如下图中所

示。若 USB 不为电路板供电，请选择 Power Cycle 编程模式。

图 6-52.  选择 MiniProg3

5. 准备好时，请按下 Program 按键（或在菜单项中依次选择 File > Program），以编程 PSoC 5LP
器件。
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6. 编程完成后，将出现以下信息 “Program Finished at <time>” （编程在 < 时间 > 内完成）。

图 6-53.  编程完成

7. 用户已成功地恢复 PSoC 5LP 的出厂设置。它可作为 PSoC 4 器件上的编程器 / 调试器使用。

6.5 使用 µC/Probe 工具

Micrium 公司的 µc/probe 是一个 Windows 应用程序，让您可以在运行时对任何嵌入式目标处理器的

内存执行读写操作，以及绘制这些值到一个图形化的仪表盘，从而形成一组虚拟控制和指标。

通过使用该工具，用户可以轻松地为开发套件中各示例项目进行简单的 GUI 设计。

请注意， Micrium µC/Probe 工具不是执行该套件必要的软件，并未包含在套件安装内容中。

要想使用该工具的所有功能，用户需要单独购买工具的使用权限。但您可以在
http://micrium.com/download/ucprobe-3-0-trial-version/ 网址上免费获取该工具的教学用版本。

免费提供 μC/Probe 教学用版本是为了让你在购买前尝试该工具。更多有关 µC/Probe 工具及其使用许

可的信息，请访问 http://micrium.com/download/%c2%b5cprobe-3-0-users-manual/，了解 µC/Probe
的用户指南。

在Micrium µC/Probe版本3.3中，赛普拉斯的KitProg可作为与连接到PC的目标器件进行通讯的工具。

编译好 PSoC Creator 的示例项目时，它会生成 HEX、 LST、 MAP、 RPT 和 ELF 格式的输出文件。

ELF 文件列出了所有符号 （变量）、符号类型及其地址。 Micrium µC/Probe 工具读取 ELF 文件并检

测代码中所使用的这些符号 （全局变量）。

µC/Probe 工具提供了一系列的图形控制，如滑条、 RGB 调色板、图表、 圆环图等。可以将需要的控

制类型拖放到 µC/Probe 工作台上，并将 EFL 文件中的符号分配给相应的控制类型。

http://micrium.com/download/ucprobe-3-0-trial-version/
http://micrium.com/download/%c2%b5cprobe-3-0-users-manual/
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操作工作台时，可以在 PC 显示屏上观察同各控制类型 （滑条、图表等）相应的符号值变更。

套件中各个 CapSense 和 PWM 示例项目已经指定了合适的全局变量，因此，您可以在 GUI 上查看

CapSense 和 PWM 的输出。

注意：ELF 文件是由 PSoC Creator 生成的，在项目清除过程中，它将被删除。因此，要想使用任意

WSPX 文件，请确保已经编译好看项目，以便生成 EFL 文件。否则， µC/Probe 工具将弹出一条信

息：“ 缺少 EFL 文件 ”。

6.5.1 CapSense 示例项目

要想使用 µC/Probe 工具来观察 CapSense 项目的输出，请按照下面步骤进行操作：

1. 按照第 5 章中的步骤 1~8 将 CapSense 项目编程到 CY8CKIT-042 套件内。

2. 从 http://micrium.com/download/µcprobe-3-0-trial-version/ 网址上下载并安装 µC/Probe 工具。

3. 依次选择 Start > All Programs > Micrium > uC-Probe > Micruim uC-Probe，启动 µC/Probe。

图 6-54.  Micrium µC/Probe 

http://micrium.com/download/µcprobe-3-0-trial-version/
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4. 将 Toolbox 中的 Writable Controls 下拉列表内的 Custom Slider 选项拖放到 Datascreen1 内。

图 6-55.  添加滑条控制 

5. 接下来，将 Toolbox 中 Writable Controls 下拉列表内的 RGB Palette 选项拖放到 Datascreen1 内。

图 6-56.  添加 RGB Palette 控制 

6. 添加好两种控制类型后， DataScreen1 将如下所示：

图 6-57.  包含滑条控制和 RGB 控制的数据显示屏 
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7. 现在，请点击 Symbol Browser 窗口中的 EFL 按键。

图 6-58.  Symbol Browser 中的 EFL 按键 

8. 请浏览并指向 CapSense.ELF 文件以加载 CapSense 示例项目的符号（全局变量）。等待 ELF 文

件加载完成。EFL 文件默认为折叠状态。要想扩展 EFL 文件，请点击该文件名旁边的‘+’符号。 

9. 展开后，Symbol Browser 将显示示例项目中的所有 .C 文件。通过展开每一个文件，您可以看到 C
文件中所定义的全局变量及其名称、类型、尺寸、存储器地址等信息。 

10. 现在，请展开 main.c 文件，查看 main.c 文件中所定义的全局变量。

图 6-59.  Symbol Browser 中的全局变量 
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进阶主题

11.  将全局变量 µcSlider 拖放到自定义滑条控制面板中，从而查看滑条输出。同样，可以将全局变量

µcARGB 拖放到 RGB Palette 控制面板中，查看 RGB 输出。

图 6-60.  将滑条输出分配给自定义滑条控制面板 
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进阶主题

图 6-61.  将 RGB 输出分配给 RGB Palette 控制面板 

12. 现在，将 CY8CKIT-042 连接至 PC。点击 µC/Probe 工具中的 Settings 按键。

图 6-62.  µC/Probe 中的 Settings 按键 
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进阶主题

13. 在 µC/Probe 设置窗口中，先选择 Cypress PSoC Prog，然后选择‘Port’下拉框中的‘KitProg/
<Kit Prog number>’，并点击 OK 以启动 CY8CKIT-042 和 µC/Probe 工具间的通讯。

图 6-63.  µC/Probe 设置 
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进阶主题

14. 点击 Run 按键以执行操作。

图 6-64.  Run 按键 

15. 现在，可以在套件中的 CapSense 滑条上滑动手指并观察显示屏上 Custom Slider 和 RGB Palette
控制的输出。

图 6-65.  Custom Slider 和 RGB Palette 输出 

注意：如果您正在使用 µC/Probe 工具的教学用版本，将在启动数据显示屏前显示弹出窗口。

单击 OK 按键，继续操作。使用教学用版本时，数据显示屏 （输出）也会在 1 分钟后超时。

16. 点击 File 选项卡，然后选择 Save 以保存 µC/Probe 项目。为项目输入合适的名称，并选择一个位

置用以保存您的项目。 µC/Probe 项目被存储为扩展格式（.WSPX）双击 .WSPX 文件，打开 µC/
Probe 工具。

6.5.2 PWM 示例项目

PWM 项目的 µC/Probe 项目已经创建好，并和套件内容一同被打包。您可以在安装文件夹

（<Install_Directory>\CY8CKIT-042 PSoC 4 Pioneer Kit\<version>\µCProbe）中找

到 µC/Probe 项目。

1. 按照第 5 章中的步骤 1~8 将 PWM 示例项目编程到 CY8CKIT-042 套件内。

2. 双击 CY8CKIT-042_PWM.wspx 文件。
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进阶主题

3. 浏览并指向 PWM.elf 文件以加载 PWM 示例代码的符号 （全局变量）。

4. 将 CY8CKIT-042 连接到 PC 上，并按照上述的步骤 12~14 以开始运行数据显示屏。

5. 在数据显示屏上，您会观察到 PWM 比较值的图形以及由 RGB palette 控制的 RGB LED 输出。

图 6-66.  PWM 比较值和 RGB 输出 
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A. 附录

A.1 CY8CKIT-042 原理图
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A.2 引脚分配表

该部分提供了插座的引脚映射及其使用情况

A.2.1 Arduino 兼容的插座（J1、 J2、 J3、 J4 及 J12）

J1

引脚 Kit 信号 说明

J1_01 VIN 电路板的输入电压

J1_02 GND GND

J1_03 GND GND

J1_04 5 V 5 V 电压

J1_05 3.3 V 3.3 V 电压

J1_06 RESET /XRES

J1_07 IOREF I/O 电压参考

J1_08 NC 未连接

J2

引脚 PSoC 4 信号 PSoC 4 说明 引脚 PSoC 4 信号 PSoC 4 说明

J2_01 P2[0] A0 （SARADC 输入） J2_02 P0[2] 比较器 2 的同相输入引脚

J2_03 P2[1] A1 （SARADC 输入） J2_04 P0[3] 比较器 2 的反相输入引脚

J2_05 P2[2] A2 （SARADC 输入） J2_06 VDD VDD

J2_07 P2[3] A3 （SARADC 输入） J2_08 P1[5] 运算放大器 2 的同相输入引脚

J2_09 P2[4] A4 （SARADC 输入） J2_10 P1[4] 运算放大器 2 的反相输入引脚

J2_11 P2[5] A5 （SARADC 输入） J2_12 P1[3] 运算放大器 2 的输出引脚

J2_13 P0[0] 比较器 1 的同相输入引脚 J2_14 GND GND

J2_15 P0[1] 比较器 1 的反相输入引脚 J2_16 P1[2] 运算放大器 1 的输出引脚

J2_17 P1[0] 运算放大器 1 的同相输入引脚 J2_18 P1[1] 运算放大器 1 的反相输入引脚

Protection Circuit

NO LOAD
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J3

引脚 PSoC 4 信号 PSoC 4 说明

J3_01 P2[6] D8

J3_02 P3[6] D9 （PWM）

J3_03 P3[4] D10 （PWM/SS）

J3_04 P3[0] D11 （PWM/MOSI）

J3_05 P3[1] D12 （MISO）

J3_06 P0[6] D13 （SCK）

J3_07 GND GND

J3_08 P1[7] AREF

J3_09 P4[1] SDA 

J3_10 P4[0] SCL

J4

引脚 PSoC 4 信号 PSoC 4 说明

J4_01 P0[4] D0 （RX）

J4_02 P0[5] D1 （TX）

J4_03 P0[7] D2

J4_04 P3[7] D3 （PWM）

J4_05 P0[0] D4

J4_06 P3[5] D5 （PWM）

J4_07 P1[0] D6 （PWM）

J4_08 P2[7] D7

J12

引脚 Kit 信号 PSoC 4 说明

J12_01 P3[1] MISO

J12_02 PSoC 4_VDD VDD

J12_03 P0[6] SCK

J12_04 P3[0] MOSI

J12_05 /XRES PSoC 4 RESET

J12_06 GND GND



CY8CKIT-042 PSoC® 4 Pioneer 套件指南， 文档编号：001-90179 版本 *B 118

A.2.2 Digilent Pmod 卡支持插座（J5）

J5

引脚 Kit 信号
PSoC 4 定义

（默认 Pmod 信号）

J5_01 P3[5] SPI_SS （与 J4_06 复用）

J5_02 P3[0] SPI_MOSI

J5_03 P3[1] SPI_MISO

J5_04 P0[6] SPI_SCK

J5_05 GND GND

J5_06 VDD VCC
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A.2.3 PSoC 5LP GPIO 插座（J8）

J8 是 2 x 6 的插座，用于连接 PSoC 5LP 的各个引脚，以便支持自定义 PSoC5LP 项目的 GPIO 控制。

A.3 编程和调试插座

A.3.1 PSoC 4 直接编程 / 调试插头（J6）

A.3.2 PSoC 5LP 直接编程 / 调试插头（J7）

J8

引脚 PSoC 5LP 信号 PSoC 5LP 说明 引脚 PSoC 5LP 信号 PSoC 5LP 说明

J8_01 PSoC 5LP_VDD VDD J8_02 P1[2] 数字 I/O

J8_03 P0[0] Delta Sigma ADC + 输入 J8_04 P0[1] Delta Sigma ADC – 输入

J8_05 P3[4] SAR – 输入 J8_06 P3[5] SAR + 输入

J8_07 P3[6] 缓存 VDAC J8_08 P3[7] 缓存 VDAC

J8_09 P12[6] UART RX J8_10 P12[7] UART TX

J8_11 GND GND J8_12 P3[0] IDAC 输出

J6

引脚 PSoC 5LP 信号 PSoC 4 信号 说明 引脚 PSoC 5LP 信号 PSoC 4 信号 说明

J6_01 VDD VDD VCC J6_02 P2[0] P3[2] TMS/SWDIO

J6_03 GND GND GND J6_04 P2[1] P3[3] TCLK/SWCLK

J6_05 GND GND GND J6_06 P2[2] NC TDO/SWO

J6_07 NC GND GND J6_08 P2[3] NC TDI

J6_09 GND GND GND J6_10 P2[4] XRES RESET

J7

引脚 PSoC 5LP 信号 说明 引脚 PSoC 5LP 信号 说明

J7_01 VDD VCC J7_02 P1[0] TMS/SWDIO

J7_03 GND GND J7_04 P1[1] TCLK/SWCLK

J7_05 GND GND J7_06 P1[3] TDO/SWO

J7_07 GND GND J7_08 P1[4] TDI

J7_09 GND GND J7_10 XRES RESET
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A.4 使用的电阻大小为 0 Ω和空载状态

A.5 固件运行状态 / 出错的 LED 指示

注意：如果 PSoC 5LP 中正在运行自定义项目，那么 LED 状态不可用。

单元 电阻 用法

电源 R2 通过焊接大小为 0 Ω的电阻来获取 VBUS （USB）的电压。

PSoC 5LP 和 PSoC 4 间的 I2C 连接 R24 和 R25
拆除这些电阻，以便使用 PSoC 5LP 同外部 PSoC 进行通信。移除

这两个电阻会禁用 PSoC 4 同 PSoC 5LP 器件间的 I2C 通信接口。

PSoC 4/ 外部 PSoC 编程 / 调试插座
R32、 R33 和
R34

拆除这些电阻，以断开 SWD 线与 PSoC 4 的连接。使用 J6 进行连

接并编程外部 PSoC。移除这些电阻时，会禁用 PSoC 5LP 器件对

PSoC 4 进行的编程。

保护电路 R46 拆除大小为 0 Ω的电阻，以旁路整个保护电路。

CapSense 调试电路 R1 
配置为 CSD 的 RBleed 模式时会使用到该电阻。要想使用该功能，

用户必须安装一个 Rbleed 电阻。请参见 CapSense 组件数据手册。

CapSense 屏蔽设置 R44 和 R45
拆除连接屏蔽至地面的电阻 R45，并在 R44 位置上焊接一个零欧姆

电阻，用于将 Vref 连接至 P0_1。

PSoC 4 R4、 R6
拆除电阻 R4，以便关闭供给 VTARG 的电源； 焊接大小为 0 Ω的电

阻 R6，可通过使用 VDD （而不是使用 J13）供电给 P4_VDD。

PSoC 5LP 编程器 / 调试器 R11、 R12、
R14、R15、R16

预留以供将来使用

R5 拆除大小为 0 Ω的电阻，以关闭供给 PSoC 5LP 的 VDD 电源。

R7 预留以供将来使用

用户指示 场景 用户需要执行的操作

1
快速闪烁 LED （ON 时间 = 0.25 s，
OFF 时间 = 0.25 s）

Bootloadable 文件被

损坏

通过 USB 接口，引导加载 *.cyacd 文件，该文件由使

用PSoC Creator附带的Bootloader主机GUI的PSoC
编程器提供的。这些文件位于 PSoC 
Programmer 的安装根目录下。

2
慢速闪烁 LED （ON 时间 = 1.5 s，
OFF 时间 = 1.5 s）

按下 PSoC 4 复位开关

进入 Bootloader 模式

a) 如果无意进入此模式，请拔掉电源，然后重新接通

开关， LED 会显示指示。 

b) 如果故意进入该模式，则使用由 PSoC Creator 提
供的 Bootloader 主机工具下载 *.cyacd 文件。

3 LED 持续点亮 编程器应用成功运行
成功枚举 USB，且启动并运行编程器。现在可以使用

板上 PSoC 5LP 编程器随时编程 PSoC 4 器件。
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A.6 材料表 （BOM）

编号 数量 参考 数值 说明 制造商 制造商器件型号

1

PCB， 3.32"x2.1"、CAF 电阻，高熔点

（Tg），表 面 处 理 采 用 化 学 镍 金

（ENIG），四层，颜色为红色， 丝网印

刷为白色。

赛普拉斯

2 1 C1 2200 pFd CAP CER 2200PF 50V 5% NP0 0805 Murata
GRM2165C1H222JA0
1D

3 12
C2、 C7、 C12、 C14、
C15、C17、C20、C21、
C22、 C24、 C25、 C27

0.1 uFd CAP .1UF 16V CERAMIC Y5V 0402 Panasonic - ECG ECJ-0EF1C104Z

4 11
C3、 C5、 C8、 C10、
C11、C13、C18、C19、
C23、 C26、 C28

1.0 uFd
CAP CERAMIC 1.0UF 25V X5R 0603
10%

Taiyo Yuden TMK107BJ105KA-T

5 1 C4 10 uF 25V CAP TANT 10UF 25V 10% 1210 AVX Corporation TPSB106K025R1800

6 1 C6 22 uF 16V CAP TANT 22UF 16V 10% 1210 AVX Corporation TPSB226K016R0600

7 1 C9 10000 pFd CAP CER 10000PF 50V 5% NP0 0805 Murata
GRM2195C1H103JA0
1D

8 1 C16 0.01 uFd
CAP 10000PF 16V CERAMIC 0402
SMD

Panasonic - ECG ECJ-0EB1C103K

9 6
D1、 D2、 D4、 D11、
D12、 D13

MBR05
DIODE SCHOTTKY 0.5A 20V 
SOD-123

Fairchild 
Semiconductor

MBR0520L

10 1 D3 琥珀色大功率 LED LED AMBER 591NM DIFF LENS 2012
Sharp 
Microelectronics

LT1ZV40A

11 1 D5
稳压二极管的电压

为 2 V
DIODE ZENER 2V 500MW SOD123 Diodes Inc BZT52C2V0-7-F

12 3 D6、 D7、 D8 ESD 二极管 SUPPRESSOR ESD 5VDC 0603 SMD Bourns Inc. CG0603MLC-05LE

13 1 D9 RGB 三色 LED LED RED/GREEN/BLUE PLCC4 SMD Cree, Inc.
CLV1A-FKB-
CJ1M1F1BB7R4S3

14 1 D10 状态 LED 为绿色 LED GREEN CLEAR 0805 SMD Chicago Miniature CMD17-21VGC/TR8

15 1 F1 FUSE
PTC 可恢复的熔断器，其电压为

15 V，电流为 100 A
Bourns MF-MSMF050-2

16 2 J1、 J4 8x1 RECP 
CONN HEADER FEMALE 8POS .1"
GOLD

Sullins Connector 
Solutions

PPPC081LFBN-RC

17 1 J2 9x2 RECP
CONN HEADER FMAL 18PS.1" DL
GOLD

Sullins Connector 
Solutions

PPPC092LFBN-RC

18 1 J3 10x1 RECP
CONN HEADER FMALE 10POS .1"
GOLD

Sullins Connector 
Solutions

PPPC101LFBN-RC

19 1 J6
50MIL KEYED 
SMD

CONN HEADER 10 PIN 50MIL
KEYED SMD

Samtec FTSH-105-01-L-DV-K

20 1 J8 6x2 RECP
CONN HEADER FMAL 12PS.1" DL
GOLD

Sullins Connector 
Solutions

PPPC062LFBN-RC

21 1 J9 3p_jumper
CONN HEADER VERT SGL 3POS
GOLD

3M 961103-6404-AR
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22 1 J10 USB Mini B
CONN USB MINI AB SMT RIGHT
ANGLE

TE Connectivity 1734035-2

23 1 J13 2p_jumper
CONN HEADER VERT SGL 2POS
GOLD

3M 961102-6404-AR

24 3 Q1、 Q2、 Q3 PMOS MOSFET P-CH 30V 3.8A SOT23-3 Diodes Inc DMP3098L-7

25 1 R3 560 W RES 560 W 1/8W 5% 0805 SMD Panasonic - ECG ERJ-6GEYJ561V

26 12
R4、 R11、 R12、 R14、
R15、R16、R24、R25、
R32、 R33、 R34、 R45

0 RES 0.0 W 1/10W 0603 SMD Panasonic-ECG ERJ-3GEY0R00V

27 1 R5 0 RES 0.0 W 1/8W 0805 SMD Panasonic-ECG ERJ-6GEY0R00V

28 4 R8、 R9、 R22、 R23 2.2K RES 2.2 kW 1/10W 5% 0603 SMD Panasonic - ECG ERJ-3GEYJ222V

29 2 R10、 R41 4.7K RES 4.7 kW 1/10W 5% 0603 SMD Panasonic-ECG ERJ-3GEYJ472V

30 1 R13 100K RES 100 kW 1/10W 5% 0402 SMD Panasonic - ECG ERJ-2GEJ104X

31 5
R17、R18、R19、R20、
R21

560 W RES 560 W 1/10W 5% 0603 SMD Panasonic-ECG ERJ-3GEYJ561V

32 2 R26、 R27 22E RES 22 W 1/10W 1% 0603 SMD Panasonic - ECG ERJ-3EKF22R0V

33 1 R28 2.2K RES 2.2 kW 1/8W 5% 0805 SMD Panasonic - ECG ERJ-6GEYJ222V

34 2 R29、 R30 1.5K RES 1.5 kW 1/8W 5% 0805 SMD Panasonic - ECG ERJ-6GEYJ152V

35 1 R31 330 W RES 330 W 1/8W 5% 0805 SMD Panasonic - ECG ERJ-6GEYJ331V

36 1 R35 232 W RES 232 W 1/10W 1% 0603 SMD Panasonic - ECG ERJ-3EKF2320V

37 1 R36 120 W RES 120 W 1/10W 1% 0603 SMD Panasonic - ECG ERJ-3EKF1200V

38 2 R37、 R39 1.5K RES 1.5K W 1/10W 5% 0603 SMD Panasonic - ECG ERJ-3GEYJ152V

39 2 R38、 R40 3K RES 3.0K W 1/10W 5% 0603 SMD Panasonic - ECG ERJ-3GEYJ302V

40 1 R42 1 K RES 1K W 1/8W 5% 0805 SMD Panasonic - ECG ERJ-6GEYJ102V

41 1 R43 442 W RES 442 W 1/10W 1% 0603 SMD Panasonic - ECG ERJ-3EKF4420V

42 2 SW1、 SW2 SW PUSHBUTTON
SWITCH TACTILE SPST-NO 0.05A 
12 V

Panasonic - ECG EVQ-PE105K

43 1 TP5 BLACK TEST POINT PC MINI .040"D Black
Keystone 
Electronics

5001

44 2 TVS1、 TVS2 5 V 350 W TVS UNIDIR 350W 5V SOD-323 Dioded Inc SD05-7

45 1 TVS4 18 V 350 W TVS DIODE 18V 1CH BI SMD Bourns Inc. CDSOD323-T18C

46 1 U1 NCP1117DTARKG NCP1117DTARKG
ON 
Semiconductor

NCP1117DTARKG

47 1 U2
PSoC 4 
（CY8C4245AXI-
483）

44TQFP PSoC4A 目标芯片
Cypress 
Semiconductor

CY8C4245AXI-483

编号 数量 参考 数值 说明 制造商 制造商器件型号
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48 1 U3
PSoC 5LP 
（CY8C5868LTI-
LP039）

用于通过 USB 调试通道和 USB 串行接

口进行调试的 68QFN PSoC 5LP 芯片

Cypress 
Semiconductor

CY8C5868LTI-LP039

未安装组件

49 1 C29 1.0 uFd
CAP CERAMIC 1.0UF 25V X5R 0603
10%

Taiyo Yuden TMK107BJ105KA-T

50 1 J5 6X1 RECP RA
CONN FEMALE 6POS .100" R/A
GOLD

Sullins Connector 
Solutions

PPPC061LGBN-RC

51 1 J7
50MIL KEYED 
SMD

CONN HEADER 10 PIN 50MIL
KEYED SMD

Samtec FTSH-105-01-L-DV-K

52 1 J11 2 PIN HDR
CONN HEADER FEMALE 8POS .1"
GOLD

Sullins Connector 
Solutions

PPPC021LFBN-RC

53 1 J12 3x2 RECPT
CONN HEADER FMAL 12PS.1" DL
GOLD

Sullins Connector 
Solutions

PPPC032LFBN-RC

54 5 R1、R2、R7、R44、R46 0 RES 0.0 W 1/10W 0603 SMD Panasonic-ECG ERJ-3GEY0R00V

55 1 R6 0 RES 0.0 W 1/8W 0805 SMD Panasonic-ECG ERJ-6GEY0R00V

56 2 TP1、 TP2 RED TEST POINT PC MINI .040"D RED
Keystone
 Electronics

5000

57 3 TP3、 TP4、 TP6 BLACK TEST POINT PC MINI .040"D Black
Keystone 
Electronics

5001

58 1 TVS3 5 V 350 W TVS UNIDIR 350W 5V SOD-323 Dioded Inc SD05-7

按照拐角中字符层来安装 PCB 底部

59 4 N/A N/A
BUMPON CYLINDRICAL.312X.215
BLACK

3M SJ61A6

特殊跳线器的安装说明

60 1 J9
在引脚 1 和 2 上安

装跳线器 
矩形连接器 MINI JUMPER GF 6.0MM
CLOSE TYPE BLACK

Kobiconn 151-8010-E

61 1 J13
在引脚 1 和 2 上安

装跳线器

矩形连接器 MINI JUMPER GF 6.0MM
CLOSE TYPE BLACK

Kobiconn 151-8010-E

标签

62 1 N/A N/A
LBL，套件产品标识标签，供应商代码，

生产日期，序号 CY8CKIT-042 版本 **
（YYWWVVXXXXX）

Cypress 
Semiconductor

63 1 N/A N/A
LBL, PCBA 防静电警告，

 10mm X 10mm
Cypress 
Semiconductor

64 1 N/A N/A 汇编不干胶标签，制造 ID 
Cypress 
Semiconductor

65 1 N/A N/A 套件 QR 代码
Cypress 
Semiconductor

编号 数量 参考 数值 说明 制造商 制造商器件型号
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A.7 法规遵从信息

CY8CKIT-042 PSoC 4 已经过测试和验证，符合下列电磁兼容性 （EMC）规定：

■ EN 55022:2010 A 级 — 辐射

■ EN 55024:2010 A 级 — 抗干扰 

A.8 在不同的 Pioneer 系列套件上进行项目移植

全部赛普拉斯 Pioneer 系列套件均是 Arduino Uno 兼容的，并拥有一些常见的板上外设 （如 RGB 三

色 LED、 CapSense 和用户开关）。然而，由于使用的 PSoC 器件引脚功能存在差异，因此各板的引

脚映射情况也有所不同。本指南列出了 Pioneer 系列套件的引脚映射情况，以便在不同的套件上可以

轻松进行项目移植。

在某些情况下， Pioneer 套件插座上可用的引脚是标准 Arduino Uno 引脚的超集。例如，在 Arduino
Uno 引脚分布上， J2 包含一行引脚，而在诸多 Pioneer 系列套件上，它包含两行引脚。

图 A-1.  Pioneer 系列套件引脚映射 

Pioneer series kits

J1
J2

J3 J4

18 1

2

11 810

17

18

11

12

CY8CKIT-040

CY8CKIT-042-BLE

CY8CKIT-042 & CY8CKIT-044

6x1 header

6x2 header

9x2 header

Arduino compatible
I/O headers

Arduino compatible
power header



CY8CKIT-042 PSoC® 4 Pioneer 套件指南， 文档编号：001-90179 版本 *B 125

A.8.1 Arduino Uno 兼容的插座

J1 Arduino 兼容的插座引脚映射

引脚
编号

Arduino 引脚
Pioneer 系列套件

CY8CKIT-042 CY8CKIT-040 CY8CKIT-042-BLE CY8CKIT-044

1 VIN VIN VIN VIN VIN

2 GND GND GND GND GND

3 GND GND GND GND GND

4 5 V V5.0 V5.0 V5.0 V5.0

5 3.3 V V3.3 V3.3 V3.3 V3.3

6 RESET RESET RESET RESET RESET

7 IOREF P4.VDD P4.VDD BLE.VDD P4.VDD

8 NC NC NC NC NC

J2 Arduino 兼容的插座引脚映射

引脚
编号

Arduino 引脚
Pioneer 系列套件

CY8CKIT-042 CY8CKIT-040 CY8CKIT-042-BLE CY8CKIT-044

1 A0 P2[0] P0[0] P3[0] P2[0]

2 – P0[2]* – P2[0] P2[6]*

3 A1 P2[1] P0[1] P3[1] P2[1]

4 – P0[3]* – P2[1]* P6[5]*

5 A2 P2[2] P0[2]* P3[2] P2[2]

6 – P4_VDD – P2[2]* P0[6]*

7 A3 P2[3] P0[4]* P3[3] P2[3]

8 – P1[5]* – P2[3]* P4[4]*

9 A4 P2[4] P1[3] P3[4] P2[4]

10 – P1[4]* – P2[4]* P4[5]*

11 A5 P2[5] P1[2] P3[5] P2[5]

12 – P1[3]* – P2[5]* P4[6]*

13 – P0[0] – – P0[0]

14 – GND – – GND

15 – P0[1] – – P0[1]

16 – P1[2]* – – P3[4]*

17 – P1[0] – – P0[7]*

18 – P1[1]* – – P3[5]*

* 这些引脚还可以使用于板上外设。更多详细信息，请查看下面板上外设部分中的各表



CY8CKIT-042 PSoC® 4 Pioneer 套件指南， 文档编号：001-90179 版本 *B 126

J3 Arduino 兼容的插座引脚映射

引脚
编号

Arduino 引脚
Pioneer 系列套件

CY8CKIT-042 CY8CKIT-040 CY8CKIT-042-BLE CY8CKIT-044

1 D8 P2[6] P1[4] P0[5] P0[2]

2 D9 P3[6] P1[5] P0[4] P0[3]

3 D10 P3[4] P1[6] P0[2] P2[7]

4 D11 P3[0] P1[1]* P0[0] P6[0]

5 D12 P3[1] P3[1] P0[1] P6[1]

6 D13 P0[6] P1[7] P0[3] P6[2]

7 GND GND GND GND GND

8 AREF P1[7] NC VREF P1[7]

9 SDA P4[1] P1[3] P3[4] P4[1]

10 SCL P4[0] P1[2] P3[5] P4[0]

* 这些引脚还可以使用于板上外设。有关连接情况的更多详细信息，请查看下面板上外设部分中的各表。

J4 Arduino 兼容的插座引脚映射

引脚
编号

Arduino 引脚
Pioneer 系列套件

CY8CKIT-042 CY8CKIT-040 CY8CKIT-042-BLE CY8CKIT-044

1 D0 P0[4] P0[5] P1[4] P3[0]

2 D1 P0[5] P0[6] P1[5] P3[1]

3 D2 P0[7]* P0[7] P1[6] P1[0]

4 D3 P3[7] P3[2]* P1[7] P1[1]

5 D4 P0[0] P0[3] P1[3] P1[2]

6 D5 P3[5] P3[0] P1[2] P1[3]

7 D6 P1[0] P1[0] P1[1] P5[3]

8 D7 P2[7] P2[0]* P1[0] P5[5]

* 这些引脚还可以使用于板上外设。有关连接情况的更多详细信息，请查看下面板上外设部分中的各表。
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A.8.2 板上外设

CapSense 引脚映射

引脚
编号

说明

Pioneer 系列套件

CY8CKIT-042

（线性滑条）
CY8CKIT-040

CY8CKIT-042-BLE

（线性滑条）

CY8CKIT-044

（手势板）

1 CSS1 P1[1] – P2[1] P4[4]

2 CSS2 P1[2] – P2[2] P4[5]

3 CSS3 P1[3] – P2[3] P4[6]

4 CSS4 P1[4] – P2[4] P3[4]

5 CSS5 P1[5] – P2[5] P3[5]

6 CMOD P4[2] P0[4] P4[0] P4[2]

7 CTANK P4[3] P0[2] P4[1] P4[3]

接近感应插座引脚映射

引脚
编号

说明
Pioneer 系列套件

CY8CKIT-042 CY8CKIT-040 CY8CKIT-042-BLE CY8CKIT-044

1
接近

– P2[0] P2[0] P3[7]

2 – – – P3[6]

RGB 三色 LED 引脚映射

引脚
编号

颜色
Pioneer 系列套件

CY8CKIT-042 CY8CKIT-040 CY8CKIT-042-BLE CY8CKIT-044

1 红色 P1[6] P3[2] P2[6] P0[6]

2 绿色 P0[2] P1[1] P3[6] P2[6]

3 蓝色 P0[3] P0[2] P3[7] P6[5]

用户开关引脚映射

引脚
编号

说明
Pioneer 系列套件

CY8CKIT-042 CY8CKIT-040 CY8CKIT-042-BLE CY8CKIT-044

1 SW2 P0[7] – P2[7] P0[7]
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